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Chapter 1  
Using This Guide 

Introduction 
This guide describes Project Builder, a component of the System Tools 
in the M-Tool family of products. This chapter describes: 

• user guide organization 

• chapter organization 

• online help 

• guide conventions 

© May 1, 2002 Johnson Controls, Inc. www.johnsoncontrols.com 
 Code No. LIT-693205 Software Release 5.1 
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Key Concepts 
User Guide Organization 

This guide is divided into chapters based on program features or 
components. 

Table 1-1: Project Builder User’s Guide Overview - Chapters 
Chapters Title Description 
Chapter 1 Using This Guide The current chapter provides an overview of the structure of the 

guide. 
Chapter 2 Introduction to Project 

Builder 
This chapter describes the requirements of the Project Builder and its 
relationship to the other System Tools. 

Chapter 3 Getting Started This chapter describes the basics of Project Builder: the main screen, 
menus, starting the program, creating or opening projects, adding 
devices and objects to projects, and configuring devices or objects in 
projects. This chapter is generic and tells you how to configure an 
object, but does not describe the specific details for different types of 
objects. Please refer to the Object Dictionary for more information on 
each type of object. 

Chapter 4 Defining a Site This chapter describes the details of defining the site object and the 
interconnection between Project Builder and Site Book. 

Chapter 5 Importing Files Project Builder allows you to import existing controller configuration 
files from other Johnson Controls configuration tools such as the 
HVAC PRO tool, the XTM Configurator, and the GX-9100 Software 
Configuration Tool. Metasys Integrator® (MIG) Vendor 
Communication Table (.vct) also can be imported in Project Builder. 
This chapter describes how to import and edit those files before 
adding them to your project database. This chapter also describes 
how to import Advanced Installation Management (AIM) Point and 
Room Schedules. 

Chapter 6 Working with Objects 
and the M-View 
Screen 

The N30 Supervisory Controller system is based on object-oriented 
technologies. This chapter describes the capabilities of objects and 
their use in creating and configuring projects. This chapter also 
describes the use of the M-View screen to define and configure 
objects added to a project database. The M-View screen is the 
standard object editing screen in Project Builder. All objects in Project 
Builder except for the Schedule, Calendar, and Display objects are 
edited via the M-View screen. You also can edit objects directly on 
Project Builder’s main grid. There is also an Object Browser that 
allows you to copy attribute references from one object to another. 

Chapter 7 Using M-Display to 
Configure an LDT 

Menus in the Local Display Terminal (LDT) are defined in a Display 
object and configured via a control called M-Display. This chapter 
explains how to add and edit the Display object in Project Builder. 

Chapter 8 Adding and Editing 
Schedules 

Schedule objects in Project Builder are configured and edited via a 
custom graphical interface. This chapter describes how to add and 
edit Schedules in Project Builder. 

Chapter 9 Adding and Editing a 
Calendar 

Calendar objects are created as exceptions to standard schedules. 
Calendar objects in Project Builder are configured and edited via a 
custom graphical interface. This chapter describes how to add and 
edit Calendars in Project Builder. 

Continued on next page . . . 
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Chapters (Cont.) Title Description 
Chapter 10 Using Queries Project Builder provides the ability to organize your project 

according to almost any criteria you need. This chapter 
describes how Project Builder uses queries, both simple 
Boolean and Structured Query Language (SQL), to let you 
organize the views of your project that are most useful to you. 

Chapter 11 Uploading and 
Downloading 

This chapter describes the steps required to both upload an 
existing project database to Project Builder for editing or 
archiving and downloading your completed project to your 
controllers. It includes instructions for upgrading the firmware 
version level on an N30 and for upgrading existing N30 
databases from older versions to the current version. 

Chapter 12 Using the Simulator This chapter describes how to use the Simulator, a feature that 
allows the creation of simulated N30s, allowing you to test your 
project databases before downloading them to an actual N30. 

 

Chapter Organization 
Chapters in the Project Builder User’s Guide are divided into 
four main sections as needed: 

Table 1-2: Chapter Organization 
Section Description 
Introduction Briefly outlines the contents of the chapter. 
Key Concepts Describes background information necessary 

to perform or understand specific tasks. 
Detailed Procedures Describes in detail the steps needed to 

complete specific tasks described within the 
chapter. This section is geared toward users 
who are new to Project Builder. 

Troubleshooting Provides information on potential problems as 
well as methods for solving them. 

 
If a section is not necessary for a particular chapter, it is omitted. 
For example, this chapter, Using This Guide, does not contain a 
Troubleshooting section. 
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Online Help 
The Project Builder software includes online help for Project Builder 
and for objects. The Project Builder Help file provides assistance in 
using the features of Project Builder, while the object help files 
provide details about individual objects. Access the Project Builder 
and object help screens by selecting Help from the menu bar or by 
pressing Alt+H. Pressing the F1 key automatically brings up Project 
Builder Help. The online help system for Project Builder is a cross 
platform help system that follows the basic conventions of 
Windows® 98 and Windows NT® help systems, but also incorporates 
some of the features of newer Hypertext Markup Language (HTML) 
style help. 

Guide Conventions 
As in most Windows based programs, sometimes there are multiple 
ways to perform the same tasks. This guide does not describe how to 
use both the mouse and the keyboard to perform the same step. 
In general, Microsoft® Corporation conventions are used to describe 
software features. 

 
 
Controls Group 
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Chapter 2  
Introduction to Project Builder 

Introduction 
Project Builder helps create and manage building engineering projects. 
The projects created in Project Builder are downloaded to and 
uploaded from controllers. 
This chapter describes: 

• hardware and software requirements 

• operation overview 

© May 1, 2002 Johnson Controls, Inc. www.johnsoncontrols.com 
 Code No. LIT-693210 Software Release 5.1 



 Introduction to Project Builder 2-2 

Key Concepts 
Hardware and Software Requirements 

Project Builder is part of the System Tools installed with M-Tool and 
can import files created in Configuration Tools. Project Builder also 
can import files from a Metasys Integrator® (MIG)Vendor 
Communications Table (.vct) and Advanced Installation Management 
(AIM) tools, including room schedules. 
The recommended computer platform for running Project Builder and 
M-Tool is described in the Metasys® Installation and Platform 
Requirements Technical Bulletin (LIT-12012). This guide also 
addresses various upgrade and migration issues, and extra hardware 
required to set up an N30 system. 

Operation Overview 
Project Builder allows you to create, edit, upload, and download 
N30 project databases. You can create multiple project databases at the 
same time and copy and paste information between them, saving data 
entry time. You can use Project Builder to upload files from an 
N30 and edit the data in them for use in multiple controllers. 
Existing controller configuration files, such as .prn files created with 
HVAC PRO software, .vct tables from Metasys Integrator controllers, 
or point schedules from AIM Tools, can be imported. Then you can 
edit the data in these files, add them to your project database, and 
download them to multiple controllers. 
You can edit most objects in Project Builder using the M-View screen. 
Three exceptions are the Schedule, Calendar, and Display objects, 
which have custom graphical user interfaces. You can edit some object 
attributes directly on Project Builder’s main grid. 
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Chapter 3  
Getting Started 

Introduction 
This chapter describes how to get started with Project Builder using 
the basic functions and navigation capabilities. This chapter describes 
how to: 

• start Project Builder 

• create a new project 

• open an existing project 

• add a device to a project 

• configure a device in a project database 
This chapter assumes that Project Builder has been installed properly 
with the recommended Personal Computer (PC) requirements. 

IMPORTANT: When uninstalling the latest release of Project 
Builder, certain files may remain on the PC. If you 
reinstall an earlier release of Project Builder to work 
with older N30/M-Workstation networks, these files 
can cause Project Builder to work improperly. If you 
must use two different versions of Project Builder, we 
recommend using two separate machines. 

© May 1, 2002 Johnson Controls, Inc. www.johnsoncontrols.com 
 Code No. LIT-693215 Software Release 5.1 
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Key Concepts 
Project Builder Main Window 

Figure 3-1 shows the Project Builder desktop with all items visible. 
Table 3-1 describes the parts labeled by the callouts. 

 

Figure 3-1: Project Builder Desktop 
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Table 3-1: Project Builder Desktop Callouts 
Callout Name Description 
1 Title Bar Displays the name of the currently selected project database. 
2 Menu Bar Provides access to top level of Project Builder menus. 
3* Toolbar Provides one button access to commonly used tools. 
4 Project Window Displays the current query for the current project database. 
5* Object Library Displays object types (classes) and collections that can be dragged to project 

databases. Supervisory controllers such as the N30 are listed under the 
Devices and Collections folder. 

6 Row Headers Provides means to select objects. Row headers with line numbering reflect the 
number of objects that have been made visible. That is, if a container has 
20 objects, line numbering does not reflect the number of objects until the 
container is expanded at least once in a viewing session. 

7* Memory Meter Displays the total memory capacity and the percentage of memory in use for 
the selected device as objects are added to the database. 

8* Status Window Displays Project Builder or Loader status and any error messages. 
9 Status Bar Describes menu and toolbar functions when they are selected. 
* These items are dockable and may be dragged to other parts of the desktop or hidden. 
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Project Builder Main Window Menus 
Table 3-2 describes the menus and commands available from the 
Project Builder main window. 

Table 3-2: Project Builder Main Window Menu Options 
Menu Command Description 
File New Ctrl+N Creates a new project database. 
 Open… Ctrl+O Opens an existing project database. 
 Close Closes the selected project database. 
 Import > Allows you to import N2 Controller Files, AIM Point Schedules or 

MIG .vct files. 
 Save Ctrl+S Saves changes to the current project. 
 Save As Allows you to save the current project with a new name. 
 Print… Ctrl+P Prints the information in the current project window. 
 Print Preview Shows what is printed if the print command is used. 
 Print Setup… Opens the setup dialog box for the current printer. 
 Properties… Shows the project properties box for the selected project. 
 1 Project1.mpb Lists the last four projects. 
 Exit Closes Project Builder. 
Edit Cut Ctrl+X Removes the selected item and places it on the Windows operating 

system clipboard. 
 Copy Ctrl+C Copies the selected items to the Windows clipboard. 
 Paste Ctrl+V Pastes the contents of the Windows clipboard to the current 

insertion point. 
 Mass Copy… Creates user-specified number of duplicates of the selected items. 
 Edit Object… Opens the Edit Attributes dialog box (M-View) for the selected 

object. 
 Delete Objects Del Removes selected objects from the project database. 
 Edit Site… Opens the Edit Site dialog box. 
 Find… Ctrl+F Searches the selected column for the specified text. 
 Replace… Ctrl+H Allows you to search for, and replace, specific text. 
View Refresh Refreshes the current view. Requires that project be saved first. 
 Toolbar > Allows you to select which toolbars are displayed. 
 Status Bar If checked, the Status Bar is visible; otherwise it is hidden. 
 Status Window If checked, the Status Window is visible; otherwise it is hidden. 
 Memory Meter If checked, the Memory Meter is visible; otherwise it is hidden. 
 Object Browser If checked, the Object Browser is visible, otherwise it is hidden. 
 Object Library If checked, the Object Library is visible; otherwise it is hidden. 
 Refresh Object Library Updates the Object Library and the current view. 
Format Add Query… Opens the Add Query dialog box to create a new query. 
 Edit Query… Opens the Edit Query dialog box to edit the current query. 
 Delete Query Deletes the current query. 
 Add Column… Opens the Add Column dialog box to create a new column. 
 Edit Column… Opens the Edit Column dialog box to edit the current column. 
 Delete Column Deletes the selected column. 
Continued on next page . . . 
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Menu 
(Cont.) 

Command Description 

Tools Download Objects Allows you to download objects to a selected device. 
 Upload Objects Allows you to upload objects from a selected device. 
 Advanced Download… Opens the Advanced Download dialog box. 
 Abort Load Allows you to halt the current upload or download operation. 
 Database Allows you to compact the database or update classes (object 

types). Compacting a database removes unused space from the 
current project database. Updating classes updates the database 
class data to the latest version. 

 N2 Controller Tools Allows you to launch N2 Controller tools. These include HVAC PRO 
tool, HVAC PRO tool in Passthrough mode, the GX9100 tool, XTM 
Configurator, and the DX Commissioning tool. 

 Simulator Launches the Simulator, which allows you to create a software 
representation of one or more N30s on which to test your database 
prior to downloading it to your actual device. 

 Options Launches the options dialog to allow you to choose your 
N2 Controller download options. 

 M-Workstation Settings Opens the M-Workstation settings dialog box. 
Window Cascade Arranges all open project windows so that they overlap diagonally 

with the title bars showing. 
 Tile Horizontal Arranges all open project windows horizontally. 
 Tile Vertical Arranges all open project windows vertically. 
 Arrange Icons Aligns any open but minimized project icons at bottom of window. 
 1 Project1.mpb Lists open project files. 
Help Help Topics F1 Opens the online help file for Project Builder. 
 Object Help Opens the online help files for the individual objects. 
 About Project Builder… Displays copyright and version information about Project Builder. 
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Project Builder Toolbar 
Table 3-3 describes the use of the Project Builder toolbar buttons. 

Table 3-3: Project Builder Toolbar Buttons 
Toolbar Button Name Description 
Standard 

 
New Creates a new project database. 

 
 

Open Allows you to open an existing project database. 

 
 

Save Saves changes to the current project database. 

 
 

Print Prints the selected query. 

 
 

Cut Removes the selected items from the current project database and 
places them on the Windows clipboard. 

 
 

Copy Copies the selected items to the Windows clipboard. 

 
 

Paste Pastes the contents of the Windows clipboard at the current 
insertion point. 

 
 

Mass Copy Creates user-specified number of duplicates of the selected items. 

 
 

Edit Object 
Attributes 

Opens the Edit Attributes dialog box (M-View) for the selected 
object. 

 
 

Edit Site 
Configuration 

Opens the Edit Site dialog box. 

 
 

Toggle Object 
Browser 

Opens or closes the Object Browser. 

Format 
 

Add Query Opens the Add Query dialog box to create a new query. 

 
 

Edit Query Opens the Edit Query dialog box to edit the current query. 

 
 

Add Column Opens the Add Column dialog box to create a new column. 

 
 

Edit Column Opens the Edit Column dialog box to edit the current column. 

Load 
 

Upload 
Objects 

Allows you to upload objects from a selected device. 

 
 

Download 
Objects 

Allows you to download objects to a selected device. 

 
 

Advanced 
Download 

Opens the Advanced Download dialog box. 

 
 

Abort Allows you to halt the current upload or download operation. 

Help 
 

Help Topics Opens the Project Builder help file. 

 
 

Object Help Opens the Object Help files. 
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File Types 
Table 3-4 describes file types used by Project Builder. 

Table 3-4: File Types 
Extension Describes Files Containing: 
DWN N30 operating system code 
MAO Compiled classes and collections shared by all projects 
MOI Object data created upon download/upload. The Load Manager 

creates Metasys® Object Instance (MOI) files. 
MPB Project database files created by Project Builder. Although these 

files are in Microsoft® Access format, all changes to the database 
should be done through Project Builder to ensure database integrity. 

 

Loader 
The Loader is the part of the Project Builder that performs the actual 
download of objects to a controller. For more information on the 
Upload and Download options and the actions associated with them, 
see the Uploading and Downloading chapter (LIT-693250). 

Object Library 
The Object Library contains the objects and collections that can be 
added to a project database via drag and drop. The device folders, such 
as the N30 folder, contain the objects that can be used in the named 
device. The Devices and Collections folder contains predefined, 
default object collections for specific devices (the N30 Default and 
N30-1 default collections). A predefined object collection such as the 
N30 Default must be used as a starting point for creating your database 
or adding supervisory devices to the network. For definitions of these 
objects and their uses, please refer to the Project Builder’s online 
Object Help, the Object Dictionary, and the N30 Supervisory 
Controller User’s Manual. See the Working with Objects and the 
M-View Screen chapter (LIT-693230) for a list of N30 objects and the 
containers in the supervisory controller default database to which you 
can drag them. 

Project Database 
The Project Database defines all devices, objects, controllers, and 
attributes that are to be used in an N30 system. Create and edit 
databases in Project Builder, and then download to the devices in the 
system. 
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N30 Example Database 
An N30 database example is also supplied with M-Tool as a guide to 
creating objects for your N30 database. The N30 example database 
provides examples of how the object attributes must be configured for 
objects such as the Display, Multiple Command (MC) object, and 
Interlock objects. Use this database as a basis of design for any new 
project designed with Project Builder. The N30 example database.mpb 
file is located in C:\Documents and Settings\All Users\Application 
Data\Johnson Controls\M-Data\. 

Queries 
Queries are a way of requesting and organizing information in a 
project database. In Project Builder, queries appear as tabbed 
spreadsheets in the project window. 

Memory Meter 
The Memory Meter shows the estimated memory usage of a 
Johnson Controls device in a graphical and textual format. The total 
capacity of the device on which the user is working is indicated in text. 
For example, the Memory Meter shows that N30 and N30-1 devices 
do not have the same amount of total memory available. 
Notes: The estimates in Project Builder are updated to actual values 

when a device is uploaded. 
Use the Memory Meter as a guide to how many objects 
(other than N2 objects) can be added to an N30. It is not a 
replacement for stated N2 object limitations of an N30. The 
N30-0 supports up to 400 N2 objects, and the N30-1 
supports up to 800 N2 objects. Even if there is enough 
memory available in the N30, other factors, such as 
exceeding the recommended bandwidth of the processor, 
also control how many objects can work in a given N30. 

The percentage of memory used appears as a bar graph and as a 
number. While the bar is limited to 100%, the associated text can 
exceed 100% and let the user perform what-if scenarios offline. The 
memory meter bar graph is color coded. The bar is normally green. 
When the percentage of memory used reaches 90%, the bar turns 
yellow. If the memory gauge reaches 95%, the bar turns red to warn 
you that the device memory may exceed a recommended value for 
reliable operation. 
If Project Builder does not have a current estimate for the memory 
used by a device, the memory meter displays a warning that memory 
data is not available. A calculate now option is provided that allows 
the user to scan the objects for a device and calculate the memory. 
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Status Window 
The Status Window provides feedback on actions performed by 
Project Builder or the Loader. When an action cannot be performed, 
the status window displays error messages explaining the problem. 

Object Browser 
The Object Browser is a pop-up dialog box, which shows objects of 
the current Project Builder project in a tree format. The Object 
Browser helps you to enter object and attribute references in M-View. 
See the Working with Objects and the M-View Screen chapter 
(LIT-693230) for more information on the use of the Object Browser. 
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Detailed Procedures 
Starting Project Builder 

To start Project Builder: 
On the Windows Start menu, select Programs > Johnson Controls > 
M-Tool > System Tools > Project Builder. 

Creating a New Project 
To create a new Project Builder project: 
1. Select New on the File menu. The New Project screen appears 

(Figure 3-2). 

 

Figure 3-2: New Project Screen 
Note: This screen also appears when you select Properties from the 

File menu while a project database is open. 
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2. Fill in the fields according to Table 3-5, and click OK. 

Table 3-5: Create New Project Fields 
Field Contains 
Project Name Unique name for project database 
Directory Location where the project database is stored. This location 

is determined by and can be modified only with the 
M-Workstation Settings utility. 

Contract Number Contract number of the project, if applicable 
Created By Name of person creating database 
Last Modified The date and time the project database was last edited 
Version Optional, version number of project 
Description Optional, detailed description of the project database 
Note: If Integrate with AIM Tools is checked in the M-Workstation Settings utility, 

the default directory is set to the default AIM Tools directory indicated by 
the utility. The appropriate subdirectory is then determined by AIM. In this 
case, the Directory field is dimmed on the New Project screen. If an AIM 
Project Folder Manager (PFM) project is open in the background, the 
Project Name, Directory, Contract Number, and Created By fields 
automatically fill with the information stored in the PFM. See the M-Tool 
Overview and Installation Technical Bulletin (LIT-693100) for more 
information. 

 

Opening an Existing Project 
To open an existing Project Builder project: 
1. Select Open on the File menu. The Open Project dialog box 

appears. 
2. Browse to and select the project you want to open. 
3. Click Open. 

Adding a Device to a Project 
To add a device to a project: 
1. Select the device from the Devices and Collections folder in the 

Object Library (for example, the N30 Default or the N30-1 
Default as shown in Figure 3-1). 

2. Drag the selected device to an empty row in the project window. 
Note: Select the Object Library from the Project Builder View 

menu if it is not showing. 
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Configuring a Device in a Project Database 
To configure a device in a project database: 
1. Click the row header for the device in the project database. In this 

example, we are configuring an N30, so we click the N30 row 
header. 

2. Select Edit Object from the Edit menu, or double-click the row 
header. The N30 Object Edit Attributes screen appears  
(Figure 3-3), open to the M-View tab. See the Working 
with Objects and the M-View Screen chapter (LIT-693230) for 
information on using M-View. 

 

Figure 3-3: N30 Object Edit Attributes Screen in M-View 
3. Use M-View and the Object Dictionary to enter the parameters for 

the N30. 
4. Click OK to exit the M-View screen. 
5. Add object containers to the N30 as necessary. See Working with 

Objects and the M-View Screen (LIT-693230) for details on 
adding objects to an N30. 
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Notes: The predefined N30 assembly, N30 Default, contains the 
default containers for new N30 databases. 
The Universal Time Coordinated (UTC) Offset attribute in 
the M-View screen defines the UTC Offset value, in 
minutes, during Standard Time (ST). There is no need to 
adjust the UTC Offset value during Daylight Saving Time 
(DST). 
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Chapter 4  
Defining a Site 

Introduction 
You must configure a Site to set up a network of N30 devices. This 
chapter describes how to: 

• configure a site 

• access the Site Book 
For further information on the attributes of the Site object, the Site 
Data object, and the N30 Device object, see the Object Dictionary. For 
information on accessing a site in a VT100 interface, see the Getting 
Started chapter (LIT-6892030) in the N30 Supervisory Controller 
User’s Manual. 
For information on how to use the Site Book, see the Site Book User’s 
Guide (LIT-6893100). 

© May, 1 2002 Johnson Controls, Inc. www.johnsoncontrols.com 
 Code No. LIT-693220 Software Release 5.1 
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Key Concepts 
Site Object 

The Site object maintains a list of devices on the site, including 
supervisory controllers, and is responsible for the synchronization of 
global objects, time synchronization, and device status monitoring. 
There is only one Site object per project, residing in the Site Manager 
device. 

Site Data Object 
The Site Data object holds information or data relating to the site, such 
as the site name. The master Site Data object exists on the Site 
Manager device. All other devices contain copies of the Site Data 
object. 

N30 Device Object 
The N30 Device object defines the attributes that represent the 
externally visible N30 characteristics. 

Broadcast Management for BACnet™ Protocol Object 
The Broadcast Management for BACnet Protocol object (formerly 
BACnet Broadcast Management Device [BBMD] object at 
Release 1.0) is necessary for N30s on different network segments to 
talk to each other. Only one N30 per segment may contain the 
Broadcast Management object for that segment. The Broadcast 
Management object can be added or deleted only through Project 
Builder. Each Broadcast Management object contains a list of 
designated devices on other Ethernet Internet Protocol (IP) subnets to 
which to forward broadcast messages. The data in each Broadcast 
Management object must be the same in all devices that have a 
Broadcast Management object. 

Site Book 
Site Book is a program used to define and edit a database of physical 
or logical locations (sites) to which the Project Builder or an M-Series 
Workstation may connect. Each site within the database has 
parameters that are needed to establish a connection to the site. The 
Site Book configures sites for N30 devices. The Site Book also can be 
set to communicate directly to simulated N30s. 
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Site Manager Device 
A Site Manager Device is the device within a site that contains the 
master Site object. The Site Manager device provides online/offline 
alarm reporting and allows browsing the list of N30 devices and top 
level group objects from a VT100 device. If an N30 device is not 
designated as the Site Manager, a warning appears when downloading 
N30s. 

Copy Holder Device 
A Copy Holder Device is the device designated to hold a copy of the 
site data in the Site Manager. If the Site Manager goes offline, the 
Copy Holder device takes over the Site Manager role. The Copy 
Holder device backs up operator objects (objects that hold the VT100 
passwords). This feature is optional. 

Message Router Object 
The Message Router object in each N30 device receives all alarm 
messages that are generated and automatically routes them to 
destinations, such as printers and workstations. This object also 
handles rerouting messages to alternate destinations and sends all 
messages requiring acknowledgement to the Report Server object. 

Notification Object 
The Notification object provides an alternate means to send alarm 
messages (Event Notification Messages) to any BACnet device. 
Typically, it is used to route alarm messages to third-party 
BACnet devices. Each Notification object must be defined with its 
own list of destinations when using this type of alarming. 
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Detailed Procedures 
Note: The following procedures assume a site connection was 

created in the Site Book, and the N30s designated as Site 
Manager device and Copy Holder device have been added 
and saved to your project database. For information on 
adding a site in Site Book and setting up communications, 
see the Site Book User’s Guide (LIT-6893100). 

Configuring a Site 
To configure a site: 
1. Select Edit Site from the Project Builder Edit menu. The Edit Site 

configuration screen appears (Figure 4-1). 
Note: If the site name you are looking for is not in the site name 

list, it has not been defined in the Site Book. Click the 
Directory button to open Site Book. See the Site Book User’s 
Guide (LIT-6893100) for more information. 

 

Figure 4-1: Edit Site Configuration Screen 
2. Modify the parameters according to Table 4-1. 
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Table 4-1: Edit Site Configuration Parameters 
Parameter Description 
Site Name Selects a site name from the drop-down list. 
Directory Opens the Site Book. 
Site Manager Device Selects a Site Manager device from the drop-down list. 
Copy Holder Device Selects a Copy Holder device from the drop-down list 

(optional). The Copy Holder device must be a different 
device from the Site Manager device. 

Min Password Length Enters the desired minimum password length. 
Site Group Object Enters the top-level group object in the group object 

hierarchy for the selected site. The Site Group object must 
exist in the database. 

Alarm Routing Options Selects the desired option to route alarms: 
• Use Message Router to route alarms automatically. 
• Use Notification objects to route alarms. 

Create Report Server 
for VT100 Alarms 

If checked, this parameter creates a Report Server object 
when the Edit Site dialog box is closed using the OK 
button. Use the Report Server to hold alarms for display at 
VT100 terminals. 

Note: If a Site Manager device is not selected, a warning appears during a 
download. This prevents online/offline alarm reporting and browsing from 
VT100 devices. 

 
3. Click OK. 
4. Click Yes when prompted to save the changes to your database. 

Two warning dialog boxes appear to confirm the changes. 

Accessing the Site Book 
To access the Site Book from Project Builder: 
1. Select Edit Site from the Project Builder Edit menu. The Edit Site 

Configuration screen appears (Figure 4-1). 
2. Click on the Directory Button. The Site Book screen appears 

(Figure 4-2). 
Note: For information on creating, editing, and deleting sites, see 

the Site Book User’s Guide (LIT-6893100). 
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Figure 4-2: Site Book Screen with a Site Selected 
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Chapter 5  
Importing Files 

Introduction 
You can create objects in a database by importing data previously 
defined by other tools. This chapter describes how to: 

• import and edit the data in N2 Controller files (including .vct files 
for Metasys Integrator® Series controllers) 

• import Advance Installation Management (AIM) Schedules 

© May 1, 2002 Johnson Controls, Inc. www.johnsoncontrols.com 
 Code No. LIT-693225 Software Release 5.1 
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Key Concepts 
N2 Controller Files 

Configuration files for N2 controllers, such as Unitary (UNT) 
controllers, Variable Air Volume (VAV) controllers, and Variable Air 
Volume Modular Assembly (VMA) 1400 Series controllers, are 
created in another tool such as HVAC PRO software. Project Builder 
can import these files to use when setting up a project database. 

Metasys Integrator Controller Files 
You cannot create Vendor Configuration Table (.vct) files for Metasys 
Integrator controllers in HVAC PRO software, but you can order them 
as a complete package (MS-MIGSW0-0). Project Builder uses the 
same menu option to import N2 Controller files and to import Metasys 
Integrator  Controller files for setting up a project database. 

N2 Controller File Import Rules 
Since the N2 controllers are not standard object controllers, the Import 
Wizard uses specific rules for converting controller data to standard 
object equivalents. You can edit any automatically generated data 
before saving the objects to the database. 
The rules are as follows: 

• The file types that can be imported are short format .prn, .hmc, 
and .dmo files for N2 controllers, and .vct files for Metasys 
Integrator  controller files (Version 5.0 and later). 

Note: When importing .dmo files into Project Builder, the Analog 
Input (AI), Binary Input (BI), and Binary Output (BO) points 
do not import if their default user name is the same as their 
tag name. Project Builder filters out these unused points. 
Make sure you enter either a user name or tag name for the 
points you want to import. 

• All controller files imported in a single import session are assigned 
to the same supervisory controller. 
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• A controller object is created for each file. 
Note: In the case of a Metasys Integrator controller file import, the 

object created reflects the equipment that is being integrated 
rather than the Metasys Integrator itself, which is 
transparent. To integrate multiple pieces of the same 
equipment through one Metasys Integrator  controller, you 
either have to select the .vct file multiple times for import or 
use the copy and paste or mass copy features of Project 
Builder to generate the appropriate number of controller 
objects. See the Working with Objects and the M-View 
Screen chapter (LIT-693230) for more information on 
copying and pasting and using the mass copy feature. 

• The controller objects are put in a container object with the 
functional name N2. 

• All controller objects generated in a single session are assigned 
controller N2 addresses consecutively, beginning at 1 or the first 
available N2 address. 

Note: The import files do not contain N2 addresses. 

• The functional names of the controller objects are the controller 
type (for example, Air Handling Unit [AHU] and DX) plus an 
index number. 

• The functional names of the point objects are the controller point 
type (AI, Analog Data Float [ADF], Analog Output [AO], 
Programmable Module Constants [PMK], and so on) plus an index 
number equal to the Net Point Address. 

• The description attributes of the point objects are assigned the 
points’ long names. 

• If you are using HVAC PRO software at Release 7.03 and earlier, 
you must select the option Generate .prn files on save, and define 
the print format as short. This option is the default setting for 
HVAC PRO software at Release 8.0 and later. 

AIM Point Schedules 
The input for the AIM Import feature is the Software Schedule sheet of 
the AIM Point Schedule. The Point Schedule is a spreadsheet tool that 
manages Metasys® points lists and can generate Data Definition 
Language (DDL) software, check-off sheets, and cable tags. The 
points list that is generated becomes part of the engineering drawing 
package used for submittal and installation. The AIM Point Schedule 
reads software information from HVAC PRO software and the 
GX tool. 
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AIM Room Schedules 
For room controllers, in addition to the Point Schedule, one or more 
Room Schedules may be available. The Room Schedule is an 
Excel based schedule of VAV boxes with associated components that 
shows the rooms served by each VAV box. All the setup parameters 
for each room controller are also included in the Room Schedule. The 
AIM Import is capable of importing the information from the Room 
Schedules through a link from the Point Schedule. 
Note: You must use AIM Release 3.1 or later to import AIM Room 

Schedule files. 

AIM File Import Rules 
The output of the AIM Import feature is objects written to the Project 
Builder database. 
Each row in the AIM Point Schedule represents a Metasys controller 
or point. From the information contained in each row, the AIM Import 
feature generates a number of objects and adds it to the Project Builder 
database (zero if the Metasys object is not supported, one for 
controllers, and one or more for points). 
To read the Point Schedule, AIM Import uses Microsoft Excel as a 
Communication (COM) server. During the import process, the AIM 
Import filters out rows based on the content of the columns. 
For example, to import general Heating, Ventilating, and Air 
Conditioning (HVAC) control objects from an AIM Point Schedule, 
mark the Generate Project Builder column with an X in the rows that 
correspond with the HVAC control objects. 
To import room control objects from a Room Schedule, enter the 
model name for the room control objects under the Generate Project 
Builder column in the rows that correspond to the room control 
objects. The number of room controllers and associated objects created 
during an import depends on the number of times the model name in 
the Generate Project Builder column of the Point Schedule matches the 
Model name in the CS Model column of the Room Schedule. The 
Room Schedule is linked through the Point Schedule’s Associated File 
Name column. (See Figure 5-1 and Figure 5-2.) 
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Figure 5-1: AIM Point Schedule 
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Figure 5-2: AIM Room Schedule 
Each AIM Release 3.x software schedule contains points for a 
single supervisory controller Network Control Module ([NCM] or 
N30); however, the complete set of points for a single supervisory 
controller may be listed on several Point Schedules. While the Project 
Builder AIM Import program is able to import one or more point 
sheets in a single session, all imported points go into a single N30. 
The import performs the following operations: 

• Locates all DCDR and N2OPEN keywords on the software 
schedule and creates the corresponding controller standard objects. 
The controller objects are placed in the N2 container object in the 
selected N30 device in the object hierarchy within the database. If 
the N2 container object does not already exist, it is created. If 
available, the program looks in a Room Schedule spreadsheet for 
additional information regarding the generation of controllers. 
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• Locates all other supported Metasys object keywords on the 
schedule that are associated with the mapped controllers and 
creates the equivalent standard objects. The standard objects are 
placed under the corresponding controller objects in the object 
hierarchy within the database. 

• Gives standard objects an Object Name consisting of the 
Metasys System Name and the Metasys Object Name separated by 
a space. For example, Object Name = ‘SystemName ObjectName’. 

Note: For objects created during Room Schedule Import, place the 
N2 address of each point at the end of the object name 
separated by a space. For example, Object Name = 
‘SystemName ObjectName N2 Address’. 

• Makes the standard object description attribute equal to the 
Metasys Expanded Identification (ID). 

• Maps all other Metasys object attributes defined in the schedule to 
corresponding standard object attributes where available. 

• Sets the standard object attributes that are required to have values, 
but do not have equivalent Metasys object attributes, to a default 
value by the import program. 

Depending upon the features used in a Metasys object, you may need 
to create additional standard objects. In most cases, you can add these 
additional objects as extensions to the main standard object. The 
import program sets up the appropriate attributes to configure the 
interdependencies between parent and child (extension) objects. 
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Detailed Procedures 
Importing and Editing the Data in N2 Controller Files (Including 
.vct Files for Metasys Integrator Series Controllers) 

Notes: When importing N2 Controller files, you have the option of 
editing data in the files prior to importing them. This option 
is mainly a timesaver. You can further edit the data in the 
files after you import the files to your project database. 
In this procedure, Metasys Integrator controller files (.vct 
files) are considered the same as N2 Controller files, as they 
are imported using the same menu command. 

To import and edit the data in N2 Controller files: 
1. Select the supervisory device to which you are importing the files 

by clicking on the associated row header. 
2. Select Import > N2 Controller Files from the File menu. The Open 

dialog box appears. 
3. Navigate to and select the N2 Controller file to import, and click 

OK. The M-Tool Import Utility dialog box appears showing the 
N2 Controller file you are importing (Figure 5-3). 

 

Figure 5-3: M-Tool Import Utility Dialog Box 
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4. Click the Add N2 files button if you want to import more 
N2 Controller files. Otherwise, click Next. The M-Tool Import 
Utility parameters list appears showing all the items contained in 
the N2 Controller file you are importing (Figure 5-4). 

 

Figure 5-4: M-Tool Import Utility Parameters List 
5. Select any parameters you do not want to import, and delete them 

using the delete key. Multiple rows may be selected and deleted at 
once. 

6. Double-click cells for parameters you want to edit before 
importing. For example, in Figure 5-4, you can use the horizontal 
scroll bar to view columns that do not display when the M-Tool 
Import Utility screen appears. When finished, click Next. The 
files are saved to your project database, and the M-Tool Import 
Utility finished screen appears (Figure 5-5). 
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Figure 5-5: M-Tool Import Utility Finished Screen 
7. Click Import to import more N2 Controller files. The M-Tool 

Import Utility then starts over. Otherwise, click Finish to return to 
Project Builder. 

Importing AIM Schedules 
Note: The targeted AIM Point Schedule has to be set up for Object 

Import to the Project Builder by putting X’s or the model 
name in the appropriate cells in the Generate Project Builder 
column of the Software Schedule. See the AIM File Import 
Rules in the Key Concepts of this chapter. 

To import and edit existing AIM Schedules: 
1. Select the supervisory device in which to import the AIM 

Schedule in Project Builder. 
2. Select Import > AIM Point Schedules from the File menu. The 

Open dialog box appears. 
3. Browse to and open the AIM Schedule from which to import 

objects. If importing Control System (CS) objects, a dialog box 
prompts you for the location of the model file that corresponds to 
the CS object. 
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Note: When the import is complete, an error list appears describing 
any errors found during the import (Figure 5-6). 

4. Use the Copy button to copy the list of errors to the clipboard; 
from the clipboard, it can be pasted into a text editor and printed. 

 

Figure 5-6: AIM Software Schedule Import Errors List 
5. Double-click any line in the error list to go to the object with the 

error, and make corrections as needed. 
6. Click Close. The AIM Software Schedule Import spreadsheet 

appears (Figure 5-7). 
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Figure 5-7: AIM Software Schedule Import Spreadsheet 
7. Use the Show Errors button to show the Error List window. Use 

the Toggle Delete button to delete unwanted objects. 
Note: The Show Errors button only appears if there are errors. 

8. Click Next. The files are saved to your project database, and the 
AIM Software Schedule Import Finished screen appears  
(Figure 5-8). 
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Figure 5-8: AIM Software Schedule Import Finished 
9. Click Import if you want to import more AIM Schedules; the AIM 

Software Schedule Import then starts over. Otherwise, click Finish 
to return to Project Builder. 
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Chapter 6  
Working with Objects and the 
M-View Screen 

Introduction 
The Project Builder uses a variety of objects to configure controllers 
and perform tasks. This chapter describes how to: 

• create objects using drag and drop 

• create objects using copy and paste 

• create objects using mass copy 

• edit objects in M-View 

• use the Object Browser with M-View 

• delete objects 

© June 28, 2004 Johnson Controls, Inc. www.johnsoncontrols.com 
 Code No. LIT-693230 Software Release 5.1 
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Key Concepts 
Objects 

Objects are a unique instance of a data structure defined according to 
the template provided by its class. Each object has its own values for 
the variables belonging to its class and can respond to the messages 
(methods) defined by its class. An object is an instance of a particular 
class. 

Object Class 
An Object Class is a type of object rather than an object. For example, 
Belgium could be an object in the object class of Countries. All objects 
that come from an object class inherit certain attributes of the object 
class in which they belong. 

You can have multiple objects with the same object identifier 
(object ID) within a device as long as the objects are from different 
object classes. For example, two Analog Value objects must have 
different object IDs, but an Analog Value object and a Binary Value 
object can have the same object ID because the objects are from 
different object classes. 

IMPORTANT: If you modify two objects within the same object class to the 
same object identifier, the download fails in Project Builder. Be sure each 
object within an object class has a unique object identifier. 

Object Name 
Indicates unique names for an object. Providing an Object Name is 
optional, but if it is defined, it must be unique throughout the site. If it 
is not defined, the full reference becomes the identifier. For example, 
Building1Floor2. The following characters are not allowed: 
@ # $ * . , ? : ‘ ’ “ ” [ or ]. 

We also recommend that you do not use the following characters: 
/ \ &. 

Child Objects 
Child Objects are elements that are related to, and listed within, an 
object. 

Extender Class 
The Extender Class is a standard object class specifically designed to 
add functionality to other standard object classes. 
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Object Browser 
The Object Browser is a pop-up dialog box that shows objects of the 
current Project Builder project in a tree format. The Object Browser 
helps you to enter object and attribute references in M-View and 
M-Display. 

M-View 
M-View is a control based on the concept of views. A view is a logical 
grouping of attributes and their respective values designed to create a 
display. The M-View control is an ActiveX® control that allows a user 
to view and edit the attributes of an individual object defined in the 
system. The control, while only able to display one view at a time, can 
have any number of views available per object. 

Note: M-View is always in Edit mode in Project Builder. 

If you right-click within the M-View control, a list of additional views 
that you may select displays (Figure 6-1). 

 

Figure 6-1: Right-click Options in M-View Control 
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Dragging Objects to Containers 
To promote a consistent organization for each N30 database, 
containers are programmed to allow the insertion of only certain types 
of objects. When attempting to drag an object to a container in a 
database, your cursor changes to show whether you are allowed to put 
the selected object in the selected container. If allowed, the icon is a 
plus sign in a square; if not allowed, the icon is a circle with a slash 
through it. For definitions of objects and their uses, refer to the Project 
Builder’s online Object Help, the Object Dictionary, and the 
N30 Supervisory Controller User’s Manual. 

Table 6-1: N30 Objects and Containers 
Objects Can Be Dragged to These Containers 
Analog Alarm *All 
Analog Totalization *All 
Auto Shutdown Programming 
AV Programming 
BACnet™ Group Group 
Broadcast Management Device Object (for example, an N30) 
BV Programming 
Calendar Schedule 
Conn Applications 
Container *All 
Controller N2 
Data Broadcast *All 
Display Operator Devices 
Demand Limiting Load Rolling (DLLR) Energy 
Email Operator Devices 
Event Enrollment *All 
Event Totalization *All 
Global Data Programming 
Group Group 
Heavy Equip Contr Energy 
Interlock Programming 
LAN Remote Destination Operator Devices 
Latch Applications 
Load Energy 
Modem Config Operator Devices 
Multiple Command Programming 
Multistate Alarm *All 
MV Programming 
Continued on next page . . . 
* Objects listed with All can be dragged into all containers, but should be dragged into the objects within the 

containers. 
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Objects (Cont.) Can Be Dragged to These Containers 
N2 AI Can be dragged only to an N2 Controller object that has been 

added to the N2 container. 
N2 AO Can be dragged only to an N2 Controller object that has been 

added to the N2 container. 
N2 BI Can be dragged only to an N2 Controller object that has been 

added to the N2 container. 
N2 BO Can be dragged only to an N2 Controller object that has been 

added to the N2 container. 
N2 MSI Can be dragged only to an N2 Controller object that has been 

added to the N2 container. 
N2 MSO Can be dragged only to an N2 Controller object that has been 

added to the N2 container. 
N2 PC Can be dragged only to an N2 Controller object that has been 

added to the N2 container. 
Notification Notification 
Operator Operator 
Optimal Start Energy 
Pager Operator Devices 
Printer Operator Devices 
Pulse Meter Energy 
Remote Destination Operator Devices 
Runtime Totalization *All 
Schedule Schedule 
Signal Select Programming 
Summary Summary 
Tempocc Schedule 
Timer Applications 
Trend Log *All 
Utility Profile Energy 
VT100 Operator Devices 
* Objects listed with All can be dragged into all containers, but should be dragged into the objects within the 

containers. 
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Collection 
Collection defines a group of standard objects, their attribute values, 
and their relationships to one another. An example is an N2MSI Alarm 
Trend object that combines an Alarm object and a Trend Log object. 
Using a collection allows objects to be created with a minimum of 
manual data entry. Most attribute values are predefined by the 
collection data. 

Standard objects are dragged from a Supervisory Controller folder in 
the Object Library (for example, the N30 in Figure 6-2). Collections 
are dragged from the Devices and Collections folder in the Object 
Library. 

 

Figure 6-2: Project Builder with N2MSI Alarm Trend Collection Expanded 
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Detailed Procedures 
Note: There are three procedures to create objects in Project 
Builder described in this section. For information on importing 
objects, see the Importing Files chapter (LIT-693225). For information 
on uploading objects, see the Uploading and Downloading chapter 
(LIT-693250). 

IMPORTANT: A Supervisory Controller object, such as the N30 Default, 
must be in the database before any other object is created. 

Although containers have a limit of 75 child objects, the Supervisory 
Controller object is limited to 50 child objects because it contains hidden 
objects. To put more than 50 objects in a supervisory controller requires 
using container objects to organize the excess objects. Use a maximum of 
50 container objects. 

The N30-0 supports up to 400 N2 objects. The N30-1 supports up to 800 N2 
objects. Use the Memory Meter as a guide when adding other types of 
objects. 

Creating Objects Using Drag and Drop 
To create objects using drag and drop: 

1. Select a class (or a collection) on the Object Library window with 
a project open, and drag it to the open project window. 

2. Drop the object on another object or container. Table 6-1 describes 
the containers into which the different types of objects can be 
dragged. 

Creating Objects Using Copy and Paste 
To create objects using copy and paste: 

1. Select the row header for the object you want to copy. 

2. Select Copy on the Edit menu. 

3. Open the database into which you want to copy if you want to 
copy an object to another project database. 

4. Select the object or container to which you want to paste the 
copied object. Table 6-1 describes the containers into which the 
different types of objects can be pasted. 

5. Select Paste on the Edit menu. 

6. Select the entire row of the object being copied or the entire row 
into which you are pasting an object. 
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Creating Objects Using Mass Copy 
To create objects using mass copy: 

1. Select the row header for the object you want to copy. 

2. Select Mass Copy on the Edit menu. The Mass Copy dialog box 
appears (Figure 6-3). 

 

Figure 6-3: Mass Copy Dialog Box 
3. Enter the number of copies you want to make in the Mass Copy 

dialog box. 

4. Select OK. The number of copies you selected is added to the 
database. 

Note: The names of the newly created objects have a number 
appended to them to distinguish them as separate objects. 



 Project Builder User’s Guide 6-9

Editing Objects in M-View 
To edit objects: 

1. Double-click the rowhead of the object you want to edit, or with 
the object selected, select Edit Object on the Edit menu. The 
M-View Edit Attributes screen appears. With the 100pht-A013 
object selected, the Edit Attributes screen in Figure 6-4 appears. 

 

Figure 6-4: M-View Edit Attributes Screen 
2. Enter the information needed for your database using the 

Object Dictionary and the specifics of your project. If the field 
includes a drop-down list, click the down arrow to display a list of 
valid attribute values. 

Note: Not all attributes can be edited. 

3. Click OK. 

Note: In multistate objects, enumeration sets must have the same 
number of states as the object. Project Builder does not check that the 
number of states matches, and downloads even if there is a 
discrepancy. 

Note: For further information on valid entries for editable attributes 
in N30 objects, see the N30 Supervisory Controller User’s Manual. 
For specific information on the Schedule and Calendar objects, see the 
Using M-Display to Configure an LDT (LIT-1201107), Adding and 
Editing Schedules (LIT-693235), or Adding and Editing a Calendar 
(LIT-693240) chapters. 
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Using the Object Browser with M-View 
To use the Object Browser with M-View: 

1. With the M-View screen open (Figure 6-4), click the Browser . . . 
button. The Object Browser appears (Figure 6-5). 

Note: The Object Browser also can be opened by clicking the 
Toggle Object Browser button on the Project Builder toolbar. 

 

Figure 6-5: Object Browser 
2. Navigate to the object with which you want to work. Click the plus 

(+) signs to expand trees and see the objects that they contain. See 
Figure 6-6. 

 

Figure 6-6: Object Browser with Expanded Objects 
3. Click the Attributes button on the Object Browser to open a sliding 

child window that lists the attributes of the object that is selected in 
the Object Browser (Figure 6-7). 
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Figure 6-7: Object Browser with Sliding Child Window 
4. Select the reference attribute on the sliding window. Click the 

Copy Reference button on the Object Browser to fill in a reference 
on an object editing control, such as M-View. This process copies 
the attribute reference to the clipboard (for example, 
N30.N2.AHU{1}.AI{1}.Present Value). 

Note: Clicking the Copy Reference button when the sliding 
window is closed copies only the object reference to the clipboard (for 
example, N30 South Building.N2.AI{1}). 

5. Select the reference field in M-View (or M-Display) and click 
paste. 

6. When finished, click the X in the upper right corner of the Object 
Browser to close the browser. You may also click the toggle 
Object Browser button on the Project Builder toolbar to close the 
browser. 
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Deleting Objects 
To delete objects: 

1. Select the row of the object you want to delete. 

2. Press the Delete key or, on the Edit menu, select Delete Objects. 

Note: Deleting an object also deletes any child objects of the object 
you are deleting. 

3. Click OK on the Object Deletion Warning dialog box. 

Note: All objects are immediately deleted from the database. This 
is unlike the adding objects process, which requires you to select 
File>Save to save the objects in the database. 

Metasys® is a registered trademark of Johnson Controls, Inc. 
All other marks herein are the marks of their respective owners. 
© 2004 Johnson Controls, Inc. 
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Chapter 7  
Using M-Display to Configure 
an LDT 

Introduction 
When a Local Display Terminal (LDT) is used on an N30, a Display 
object must be created in that N30’s database to configure the LDT 
display. The Display object is added to the Operator Devices section of 
the Project Builder database. When opened, it appears as the 
M-Display tab with the M-View control. The M-Display tab is used to 
view and configure the Local Display Terminal (LDT). A Display 
object must be created for each LDT used in a site. 
Note: You cannot create or edit Display objects using a VT100 
terminal or emulator. 

For information about the LDT, see the Local Display Terminal 
(LDT) Installation Instructions (LIT-12023). For information on the 
attributes of the Display object, see the Display Object chapter 
(LIT-1201114) in the Object Dictionary. 
This chapter describes how to : 

• add a Display object for the LDT and set its general properties 

• define units sets and enumeration sets for your LDT 

• create regular menus and submenus 

• add Schedule and Calendar submenus to the LDT 

• add and define menu items 

© May 1, 2002 Johnson Controls, Inc. www.johnsoncontrols.com 
 Code No. LIT-1201107 Software Release 5.1 
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Key Concepts 
LDT 

The LDT is a display optionally installed in the N30 Series 
supervisory controller. The LDT provides alarm notification, 
navigation, access to control setpoints, and allows display and 
modification of Display object attributes, such as temperature, heating 
and cooling setpoints, and fan override. 

M-Display 
M-Display (Figure 7-1) is the user interface to the Display object. It is 
an ActiveX control used to edit the Display object attributes that 
define the menus used in the LDT. M-Display is the tab added to the 
M-View control when a Display object is edited within Project 
Builder. M-Display acts as an interface to the Display object for 
viewing and configuring the LDT. Table 7-1 describes the areas of 
control. 

 

Figure 7-1: M-Display 
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Table 7-1: M-Display 
Area Description 
1 Contains a tree representation of the menu system defined in the Display object. The 

branches of the tree are the menus, submenus, and items that display on the LDT. 
2 With a tree item selected in Area 1, this part of the M-Display control is used to display and 

modify information associated with that item. If the selection in the tree changes, the entry 
form in Area 2 changes accordingly. 

3 This area contains a set of command buttons that provides a means for entering data to 
the tree items. 
The Add <Item> button allows you to add a new menu, submenu, or menu item, 
depending on the type of branch that is selected. For example, if you select Application 
name, the button reads Add Menu. 
The Delete button allows you to delete the selected branch. 
The Import Strings... and Export Strings... buttons allow you to import or export 
enumeration sets and units sets to text files for later reuse in another Display object. 
The Enum Sets... button accesses available enumeration sets that are defined in the 
menu system. Clicking this button also allows you to create or edit enumeration sets. 
These enumeration sets are associated with menu items of type “Enumeration”. 
The Units... button allows you to define or edit the units to be used with the menu items of 
type “Number” or “Word”. 
The Export Menu... button allows you to save the menu system to a readable text file. This 
file can be used for documenting the menu system or for comparison when translating a 
menu. However, the exported file cannot be read by M-Display. 
The About... button allows you to access version, release date, and copyright information 
about M-Display. 

 

Display Object 
Project Builder downloads the information from M-Display to the 
Display object in the N30. The Display object manages: 

• online/offline status of the LDT 

• downloads of Menu Block and Dictionary data to the display unit 

• updates of menu item data values to the LDT 

• user edits from the LDT 

• unit alarms displayed on the display unit 
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Fixed Enumeration Sets 
The M-Display control uses seven fixed enumeration sets, also called 
strings. You cannot modify or delete the fixed enumeration sets. These 
sets are described in Table 7-2. 

Table 7-2: Enumeration Sets 
Enumeration Set Contents 
ES_TmpString **Last Menu 

**First Menu 
**Top of List 
**End of List 
**Not Changeable 
**Edit Mode 
**Log Off Password 
**Lo Limit Reached 

**Hi Limit Reached 
**Password Invalid 
**Enter L-1 Password 
**Enter L-2 Password 
**Enter L-3 Password 
**No Active Alarms 
**Invalid Keystroke 
Password 

ES_Months Jan, Feb, Mar, Apr, May, Jun, Jul, Aug, Sep, Oct, Nov, Dec 
ES_Days Sun, Mon, Tue, Wed, Thu, Fri, Sat, Hol, 
ES_NoaAlmPri Critical, Serious, Important, Status 
ES_NoaAlmSta Normal 

Fault 
Off Normal 
Hi Limit 
Lo Limit 
Lo Warning 
Hi Warning 
Lo Alarm 

Hi Alarm 
Alarm 
Trouble 
Status 
Offline 
Shutdown 
Unreliable 
None 

ES_AlarmPri This enumeration set has a content specific for different Original 
Equipment Manufacturers (OEMs), otherwise, it is unused. 

ES_AlarmSta Clear, Active 
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Typical Enumeration and Units Sets 
M-Tool includes typical enumeration and units sets to increase user 
efficiency. These sets are supplied in addition to the fixed enumeration 
sets listed in Table 7-2. Just like the fixed sets mentioned above, the 
typical enumeration and units sets load when editing the Display 
object. Unlike the fixed enumeration sets however, you can edit the 
typical enumeration sets. However, changes only apply to the Display 
objects that reside in the same project as the one that has been 
modified. If changes that apply to all Display objects are required, use 
a text editor to modify the DisplayUserSetsXXyyy.eus file located in 
the C:\Documents and Settings\All Users\Application Data\ 
Johnson Controls\M-Data\Shared\Mdisplay Strings\yyy\ directory, 
where XX is typically 00 for Johnson Controls use, and yyy is the 
standard language abbreviation (for example, enu for English US) for 
the language in which you are operating M-Tool. 

User-Defined Enumeration and Units Sets 
It is important to keep in mind that text displayed on the LDT is 
limited to four rows of 20 alphanumeric characters, including the 
menu text, variable value, engineering units, and spaces between them. 
This limitation is the reason why the regular N30 enumeration and 
units sets specified in the Object Dictionary and defined in full text 
with larger displays in mind, are not used in the LDT. A suggested 
workaround to this limitation is to split a line on two or more rows. 
When defining enumeration sets, the name of each set must begin with 
ES_. You cannot duplicate names. You cannot delete sets that are 
already in use. 
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Calendar Object Reference in the LDT 
The LDT can reference a Calendar object as part of the menu items. 
However, the LDT only displays the first 16 individual dates or ranges 
of dates. If any month/week-of-month/day-of-week specification 
entries are found in the date list, they are not displayed on the LDT. 
The LDT assumes the year is every year and does not display the year. 
The display device does not support any other wildcard fields. When 
you change the calendar from the display device, it overwrites the 
calendar’s Date List attribute with the only information it has (that is, 
16 entries and only the 1st and 2nd time from each entry). This may 
eliminate any information entered from a user interface device that can 
define more complex calendar data. It is therefore very important to 
evaluate whether changes should be allowed at the LDT. The default 
capability is Read Only. Only one Calendar object can be defined per 
LDT. 
The Calendar object displays as follows on the LDT: 

Holiday Schedule 

Hol 1= Jan 01 

Hol 2= Apr 02-Apr 09 

Hol 3= May 31 

. 

. 

Hol16=  
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Schedule Object Reference in the LDT 
The LDT can reference a Schedule object as part of the menu items. 
However, the LDT only displays the first two time entries in the 
Weekly Schedule attribute for each of the days (Monday – Sunday, 
+ Holiday). The LDT assumes the first time is the start time 
(State 1 command) and the second time is the stop time 
(State 0 command). The LDT does not display the schedule command. 
It only allows State 0 or State 1. The display device obtains the holiday 
entry for the weekly schedule from the Exception Schedule attribute of 
the Schedule object. If this attribute is not defined or has no times 
entered, the holiday times are displayed as 00:00 - 00:00. This is an 
invalid time pair and no operation can occur. 
The Exception Schedule attribute of the Schedule object also contains 
values used to display an exception on the display device. This is an 
optional menu item and is used to display an exception with “start date 
@ start time” and “end date @ end time” pairs. The LDT assumes the 
year is every year and does not display the year. The display device 
does not support any other wildcard fields. When you change the 
holiday times or exceptions schedule from the LDT, it overwrites the 
Schedule’s Exception Schedule attribute with only the information it 
has. This may eliminate any information entered from a user interface 
device that can define more complex schedule data. It is, therefore, 
important to evaluate whether changes should be allowed at the LDT. 
The default capability is Read Only. 
The Exception menu items must directly follow the Weekly Schedule 
menu items in the Display object application file. All exceptions that 
have a calendar reference must access the same Calendar object. 
The Schedule object displays as follows on the LDT: 

Weekly Schedule 

Mon= 08:01 - 18:01 

Tue= 08:02 - 18:02 

Wed= 08:03 - 18:03 

Thu= 08:04 - 18:04 

Fri= 08:05 - 18:05 

Sat= 08:06 - 18:06 

Sun= 08:07 - 18:07 

Hol= 08:08 - 18:08  OR Blank line 

Exception 

Beg= Jan 01 @ 06:30 

End= Jan 03 @ 18:00 
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N30 Example Database 
An N30 database example is also supplied with M-Tool as a guide to 
creating objects for your N30 database. The N30 example database 
provides examples of how the object attributes must be configured for 
objects such as the Display, Multiple Command (MC), and Interlock 
objects. Use this database as a basis of design for any new project 
designed with Project Builder. The N30 example database.mpb file is 
located in C:\Documents and Settings\All Users\Application Data\ 
Johnson Controls\M-Data\. 
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Detailed Procedures 
Adding a Display Object for the LDT and Setting its General 
Properties 

To add and set general properties of a Display object for the LDT: 
1. Open the Project Builder database that has the N30 in which you 

want to configure an LDT. 
2. In the Project window, expand the N30 Container by clicking the 

plus sign next to it. 
3. Drag a Display object from the Object Library to the Operator 

Devices container of the N30 database. 
4. Double-click the Display object row header. The Select Language 

screen appears (Figure 7-2). 
Notes: The LDT can support many different languages. However, 

each LDT is defined by one Display object that contains its 
address and is associated to one specific language. We 
recommend that you limit the display of values through the 
LDT to a single language per N30. 
Language selection determines the language for display 
error, information messages, and the fixed enumeration sets 
listed in Table 7-2. User definition of display menu and item 
names does not change automatically. 

 

Figure 7-2: Select Language Screen 
5. The drop-down list in the Select Language screen contains a list of 

each language for which M-Display finds a fixed enumeration set 
resource file. Select a language from the list and click OK. The 
M-Display control appears (Figure 7-3). 

Notes: If you click the Cancel button on the Select Language screen, 
the dialog box closes and cancels editing of the Display 
object. 
Notice that M-Display is a tabbed control in front of an 
M-View tab. M-View is used to edit the attributes of the 
Display object that are not edited in M-Display. 
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6. With the application level selected (Figure 7-3), define 
Application attributes as described in Table 7-3. 

 

Figure 7-3: New Display Object 

Table 7-3: Application Attributes 
Attribute Default Value Description 
Application 
Name 

New Application This caption appears at the top of the LDT screen when you 
display the highest level of menus. 

Local Passwords 
Text 

None The Display object may contain up to four internal passwords. 
These passwords are defined only in the Display object and 
cannot be changed or viewed at the LDT. They are restricted to a 
four digit numeric value in the range of 0000 to 9999. 
The LDT can reference Operator objects already defined in the 
Project Builder database as part of the menu items. Please see 
Configuring Menu Items for information on referencing these 
objects to allow their passwords to be used on the LDT. 

Local Passwords 
Level 

0 The LDT has a four level password scheme. The levels are: 
Level 0 - Read Only 
Level 1 - Least Capability 
Level 2 - Medium Capability 
Level 3 - Highest Capability 
Each level has all the capabilities of the levels beneath it. That is, 
Level 3 has all the capabilities of Levels 0, 1, and 2. 

Time Format 24 Hours Allows the LDT to display the time in either 12-hour (am, pm) or 
24-hour format. 

 
7. Click on the M-View tab. The M-View screen appears  

(Figure 7-4). 
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Figure 7-4: M-View 
8. Define priority levels as necessary for the Display (see Display 

[LIT-1201114] in the Object Dictionary). 
9. In the Setup section of M-View, make sure that the Net N2 

Address matches that of your LDT. LDTs are shipped with a 
default address of 32. Addresses 32 to 35 are the only ones 
allowed for LDTs. 

10. In the Setup section of M-View, define the level of password 
required to acknowledge alarms. 

Note: The default for Password Level Ack is 1. Changing it to 0 
allows anyone to acknowledge alarms without having to use a 
password. 

11. Click the Display tab. The M-Display screen appears (Figure 7-3). 
12. Define units sets and enumeration sets as needed. See Defining 

Units Sets and Enumeration Sets for your LDT in this chapter. 
Note: Units sets and enumeration sets can be added when needed. 
If you are adding a menu item and realize you need a set that does not 
exist, this procedure can be used to add additional sets. 
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Defining Units Sets and Enumeration Sets for Your LDT 
To define units sets and enumeration sets for your LDT: 
1. In the M-Display control, press the Units button to open the Units 

Sets screen (Figure 7-5). 
Note: The Display object uses three strings for each unit: one for 
English (Imperial), one for Canadian Metric (SI Canada), and one for 
European Metric (SI Europe). The default base units attribute in the 
N30 Device object determines which of these strings is used. 

 

Figure 7-5: Units Sets Screen 
2. In the Units Sets column, click the new box, or select a units set to 

edit. The new box is the dotted line box next to the X. 
3. If adding a set, type the name of the new units set. In the example, 

we are adding a temperature set, U_Temp. 
Note: When defining units sets, the name of each set must begin 
with U_. Duplicate names are not allowed. You may not delete sets 
that are in use in menu items. 

4. In the Unit Names column, type in the units you want displayed 
for each of the three possible unit attributes. See Figure 7-6 for an 
example of a temperature units set added to the Units Sets screen. 
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Figure 7-6: Units Set Added to Units Sets Screen 
5. Click OK. The M-Display screen appears. 
6. In the M-Display control, press the Enum. Sets... button. The 

Enumeration Sets screen appears (Figure 7-7). 
7. Select from the list of fixed and typical enumeration sets or you 

may create your own. When you select a fixed enumeration set, 
the two columns on the right list the state and the associated string 
that the enumeration set contains. 

 

Figure 7-7: Enumerations Sets Screen 
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8. To create your own enumeration set, click the new box in the 
Enumeration Sets column. 

9. Type a name for the new enumeration set. In the example, we are 
putting in a binary set called StartStop. 

Note: Enumeration set names must begin with ES_. 

10. Press Enter. 
11. In the Strings column, press the new box and type in the string for 

State 0. In our example State 0 = Off. 
12. Click the new box and add all strings you want in your 

enumeration set. You can change the order of the strings using the 
up and down arrows in the Strings column, or you can delete 
strings by pressing the red X button. 

13. Click OK when finished. See Figure 7-8 for an example of a user 
created enumeration set. 

 

Figure 7-8: New Enumeration Set 
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Creating Regular Menus and Submenus 

IMPORTANT: There are limitations on using the LDT to display 
schedules and calendars. Please see Adding Schedule 
and Calendar Submenus to the LDT in this chapter 
prior to adding any schedules or calendars to the LDT. 
Failure to do so can result in existing schedules and 
calendars becoming unusable. 

To create regular menus and submenus: 
1. With M-Display open, add top level menus to your LDT 

following the rules in Table 7-4 and using the methods described 
in Table 7-5. See Figure 7-9 for an example of an LDT menu 
structure. 

Table 7-4: Menu Structure Rules 
Rules for Creating a Menu Structure for an LDT 
• Only one application may be defined per Display object. 
• The hierarchy in the menu tree is limited to four levels: Application, Menus, Submenus, and Menu Items. 
• Every menu (except the Alarm and Setup/Services menus created by default when the Display object is 

defined) must have at least three submenus. 
• Each submenu must have at least three menu items. 
• If the menu structure you want to implement requires less than three submenus or three menu items, 

blank submenus and menu items may be created. 
 
2. Select the menu branch to which you want to add a submenu. 
Note: When the menu level is selected, you cannot select the 
Special Handling and Reference fields (Figure 7-9). 
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Table 7-5: Creating a Menu Structure 
Editing Method Description 
Create a New Branch You can create new branches from all components of the menu. Add a branch by 

right-clicking the branch under which you want the new branch to display, and 
selecting the type you want to add from the pop-up menu that appears. 
The pop-up menu changes depending on the level of the branch you have 
selected. For menus and submenus, the pop-up menu includes options for adding 
a branch at the same level or for adding a branch at the level immediately beneath 
the selected branch as a child. When adding branches at the same level, they can 
be differentiated by their caption. The branch created at the same level is added 
immediately after the selected branch, while the branch created as a child is added 
after the first child. 

In Place Editing When you add a menu component, you can enter the text that displays for that 
component in the LDT. You can edit the caption of a menu component by selecting 
it and pressing the F2 key. 

Selecting a Branch Selecting a branch in the menu tree activates the appropriate form associated with 
the item selected. The parameters of the menu item associated with the branch are 
presented for editing. If the currently selected menu component has been 
changed, the changes are automatically saved. However, modifications are only 
saved to the copy of the Display object local to the control. They are saved to the 
Display object in the database when the control is closed using the OK button. 

Copying and Pasting 
Branches 

You can copy branches in the menu tree (including the children) and paste them to 
a different location in the tree. There are limitations to where you can paste a 
branch. 

Changing the Order of 
Branches Using Cut 
and Paste 

You can move branches in the menu tree using cut and paste. Right-click the 
branch you want to move and select Cut. Then, right-click on the branch 
immediately above its target destination, and select Paste. You can move 
branches anywhere in the menu structure, as long as they remain at the same 
level. You cannot promote or demote branches – submenus may not become 
menus using this method. 

Delete a Branch You can remove branches in the menu tree (including the children); the parent of 
the deleted branch becomes the selected item. However, you cannot delete the 
Application item (the root). 

Renaming a Branch Using the context menu and Rename or Rename All fields, you can rename one or 
more branches at the same time. Rename changes the text of only the selected 
branch. Rename All changes the text of all the branches with the same text as the 
selected branch, regardless of whether they are expanded or collapsed. 

Figure 7-9, Figure 7-10, and Figure 7-11 are examples of the different types of editing forms in M-Display. 
Notice how the attribute entry area on the right changes, depending on the branch selected in the menu tree. 
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Figure 7-9: Example of LDT Menu Structure 
3. With a branch selected, press the Add Submenu button at the 

bottom of the control, or right-click and select Add submenu from 
the pop-up menu. 

Note: See Table 7-4 and Table 7-5 for rules and other methods of 
adding submenu branches. 

4. When defining a submenu in the Submenu Editing form 
(Figure 7-10), a Special Handling drop-down list allows you to 
select the characteristics of the submenu. For regular submenus, 
the Special Handling field should be left blank. See Adding 
Schedule and Calendar Submenus to the LDT in this chapter for 
information on using Special Handling. 

5. Continue adding menus and submenus as needed. 
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Adding Schedule and Calendar Submenus to the LDT 

IMPORTANT: There are limitations on using the LDT to display 
schedules and calendars. Please read and understand 
this section prior to adding any schedules or calendars 
to the LDT. Failure to do so can result in existing 
schedules and calendars becoming unusable. 

When adding a reference to a Schedule or Calendar object to the LDT, 
you must be aware of certain considerations in the way the LDT 
handles these objects, particularly if you give LDT users the capability 
to edit these objects from the LDT. 
The LDT is designed to display only one typical instance of all the 
possibilities of schedules that can be defined in an N30. To edit a 
schedule (or a calendar) from the LDT, we recommend that you create 
a specific Schedule object in Project Builder, for the objects on which 
you want it to take action, which follows the rules below. For example, 
create a Schedule object for simple start and stop of fans or pumps. 
That object may then be referenced in the Display object’s Schedule 
submenu. You can create more complex schedules in Project Builder 
that are not referenced in the Display object. 

• Each day in the schedule must contain a maximum of two time 
entries. If the LDT user has the capability to edit the schedule from 
the LDT, any extra time entries are eliminated from the N30 
database after the first edit action from the LDT. 

• The first time must be the start time (State 1 command) and the 
second one the stop time (State 0 command). No other type or 
sequence of command is supported. The LDT does not display the 
Schedule command. If the LDT user has the capability to edit the 
schedule from the LDT, then any other type of action (for example, 
analog command) is overwritten to a State 1 command for the first 
time entry and to a State 0 command for the second time entry 
after the first edit action. All other commands are lost. 

• If no action is to occur on holidays, leave the Exception Schedule 
attribute of the Schedule object undefined or enter no times. The 
holiday times are displayed as 00:00 – 00:00. 

• The calendar must contain a maximum of 16 dates or ranges of 
dates. If the LDT user has the capability to edit the calendar from 
the LDT, any extra entries are eliminated from the N30 database 
after the first edit action. 
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To add schedules and calendars: 
1. Add a menu for schedules. See Creating Regular Menus and 

Submenus in this chapter. 
2. Add a submenu for the type of schedule you want to add. 
3. Name the submenu. In the example in Figure 7-10, we added a 

submenu called Weekly Schedule. 
4. Select the type of Special Handling the schedule you are adding 

requires. See Table 7-6 for a description of how the Special 
Handling selections affect the submenu. In our example, we 
selected Weekly Schedule, which automatically adds the days of 
the week as menu items to our submenu. 

Note: Menu items created by the Special Handling submenus 
cannot be edited. 

Table 7-6: Submenu Special Handling 
Special Handling Selection Submenu Behavior 
None Regular menu. You can add menu items of any of the following types to 

this submenu: Enumeration, Number, Word, Password, Text, or nothing. 
Weekly Schedule When selected, the control creates eight menu items of type Time Interval 

with text Mon through “.” (period) or Hol. The last item initially has a 
period “.” for its text and Nothing for its type. If you define a Holiday 
Schedule later, the last item automatically changes to Hol and type Time 
Interval. Together, these menu items define a weekly schedule submenu. 
The submenu requires a reference. By default, the reference is preset to 
<Object Name>.PMI Refresh. You need to change the <Object Name> 
to a valid Schedule object. Once defined, the reference cannot be 
changed to another type of submenu. To change the reference, it must be 
deleted and recreated. 

Holiday Schedule When selected, the control creates sixteen menu items of type Date 
Interval with text Hol 1 through Hol 16. Together they define a holiday 
submenu. The submenu requires a reference. By default, the reference is 
preset to <Object Name>.PMI Refresh. You need to change <Object 
Name> to a valid Calendar object. Once defined, the reference cannot be 
changed to another type of submenu. To change the reference, it must be 
deleted and recreated. 

Exception When selected, the control creates two menu items of type Date and 
Time, and a third menu item of type Nothing, with captions Beg, End, and 
“.” (period). Together they define an exception menu and no reference is 
required. If used, the reference must be placed immediately after the 
Weekly Schedule. Once defined the reference cannot be changed to 
another type of submenu. To change the reference, it must be deleted 
and recreated. 

 
5. Use the Object Browser (click the Browser button) to add an 

attribute reference for the schedule. The attribute reference 
selected must end in PMI refresh. See the Working with Objects 
and the M-View Screen chapter (LIT-693230) for instructions on 
how to use the Object Browser. 
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6. Set the capability level of the schedule. A capability level of 0 
indicates that the schedule is Read Only. This is the default 
selection. 

Note: Setting the capability level to any other number allows the 
user to edit the schedule from the LDT. If the schedule is anything 
other than the binary type described at the beginning of this procedure, 
editing the schedule may make it unusable. 

 

Figure 7-10: Schedule Example 

Adding and Defining Menu Items 
To add and define menu items for the LDT: 
1. Select the submenu where you want to add menu items. 
2. Click the Add Menu Item button, or right-click and select Add 

Menu Item from the pop-up menu. The Menu Item Editing form 
(Figure 7-11) appears. 
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Figure 7-11: Menu Item Editing Form 
3. Name the menu item that you are adding and press Enter. 
4. Select the type of menu item you are adding. 
Note: Use menu items to display or modify values of N2 objects. 
Each menu item has a tag that determines its possible types. The type 
determines whether the menu item needs a reference, a password 
capability, units or enumeration set, and so on. Menu item tags and the 
types these tags determine are described in Table 7-7. For N2 objects, 
the Tag field is left blank. 
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Table 7-7: Menu Items Tags 
Tag Type of the Menu Item 
Blank Type can be selected from the Type drop-down list. Select Enumeration, Number, Word, 

Password, Text only, or nothing. 
DAYS Enumeration with the enumeration set ES_Days. No reference is necessary. 
TIME Time, no other parameters are necessary. 
DATE Date, no other parameters are necessary. 
LANGSEL Enumeration. A reference must be entered and an enumeration set must be selected. 
PW_ACK Enumeration. The reference is automatically set to <This Display Object>.Password Level 

Ack. You must select the enumeration set. Choose ES_Alm_Ack_Lvl from the list of 
possible enumeration sets. 
To change the acknowledge alarms password level from the LDT, the PW_ACK capability 
level must be set to something other than 0. However, please note that this change opens 
up the possibility to set the Ack Level down to 0. This would result in LDT users not needing 
a password to acknowledge alarms. 

PW_TIM Number. The reference is automatically set to <This Display Object>.Password Timeout. 
You must select the units. The number for this attribute is displayed in minutes. Choose 
U_Minutes from the list of possible units sets. 
To allow the Password Timeout to be edited from the LDT, the PW_TIM capability level 
must be set to something other than 0. 

UNITS Enumeration. The reference is automatically set to <This Display Object>.Display Units. You 
must select the enumeration set. Choose ES_Units from the list of possible enumeration 
sets. 
To change the LDT display units from the LDT, the units capability level must be set to 
something other than 0. 
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Table 7-8: Menu Items Types 
Type Type of the Menu Item 
Enumeration Generally used for items that have a fixed set of possible values, such as binary and 

multi-state objects, and other parameters such as day of the week, LDT Display units, 
password levels, etc. When this type is used, an enumeration set must be chosen to define 
what value is displayed on the LDT for each of the object’s possible states. 

Number Generally used for items such as analog objects. When this type of item is selected, the 
user is given the ability to select a units set if the number would benefit from being followed 
by engineering units. The user can also define the decimal precision needed, as well as 
minimum and maximum values, to which this item can be overridden if overrides are 
allowed. 

Word Used in the same manner as the Number type. 
Password The display device can reference Operator objects as part of the menu items. When used, 

the N30 operator passwords that are referenced are restricted to four digit numeric values in 
the range of 0000 to 9999 to match the restrictions of the LDT. 
These passwords also must be assigned one of the four levels of the LDT password 
scheme. The levels are Level 0 - View Only, Level 1 - Least Capability, Level 2 - Medium 
Capability, and Level 3 - Highest Capability. Each of these passwords can be viewed and 
changed from the display unit based on the capability level assigned to its menu item. 
There is no limit on the number of N30 operator passwords defined in the application. Both 
the internal and menu item passwords can be used at the same time. The display unit 
checks for a match on any menu item passwords first, and then checks for a match on 
internal passwords. See Table 7-3 for more information on internal (local) passwords. The 
display attribute Password Level Ack is the level needed by the operator to acknowledge or 
clear alarms on the display device. The user ID in the acknowledge record defaults to 
“Local”. 

Text Only Most often used when the user chooses to display values on two or more lines of the LDT. 
For example, this can be used to allow longer strings for descriptors and units. When 
displaying values on two lines, the full width of the LDT screen may be used as the item’s 
descriptor on the first line, while the value and units are displayed on the second line. 

Nothing – 
Blank Entry 

Generally used for “padding”, since the LDT requires that all menus be made up of 
three submenus, and all submenus be comprised of three menu Items. If less than 
three submenus of items are required, it is recommended to use a displayed text of “.“, and 
define its type as “Nothing – Blank Entry”. 

 
5. In the example in Figure 7-12, we have selected Enumeration for 

the type and left the tag blank. 
Note: The parameters available for editing change based on the 
type of menu item you are adding. Since we selected enumeration set 
for the type, we have a drop-down list to select from available 
enumeration sets. 
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Figure 7-12: Menu Item Example 
6. Select an enumeration set. In the example, we selected the 

StartStop set we created earlier. The Number of States field is 
automatically updated to indicate the number of states in which 
the object resides. 

7. Select the appropriate capability for commanding this object from 
the LDT. The capability defines the password level required by 
the LDT user to command this object. Choose Level 0 to make the 
object Read Only at the LDT. 

Notes: If you are modifying a menu item and realize that the 
Enumeration set or Units set needed by the item is not 
defined, you may click on the Enum.Sets... or Units... 
buttons and add the required sets. See Defining Units Sets 
and Enumeration Sets for your LDT in this chapter. When 
the dialog box for editing the sets is closed, the drop-down 
list for selecting the enumeration set or units is automatically 
updated with the new sets, and can be selected. 
For menu items that need references (see Table 7-7), the 
M-Display control automatically fills in the reference with 
<Object Name>.Present Value. If the reference is empty, an 
error box appears. 
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IMPORTANT: All non-blank tags in the table are unique; that is, there 
can be only one menu item with a certain tag. If a tag 
is associated with a menu item, the tag of the item that 
previously had it is cleared. 

8. When finished, click OK to return to the Project Builder or 
continue adding menu items, submenus, or menus. 
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Chapter 8  
Adding and Editing Schedules 

Introduction 
A schedule allows you to run events at specified times. This chapter 
explains how to: 

• add a Schedule object 

• set general properties of a schedule 

• add objects to a schedule 

• add events to a schedule using the BACnetSchedule Property Page 

• add events to a schedule using the BAC Schedule object Edit 
Attributes screen 

• copy a day’s events to other days 

• add exceptions to a schedule using the BACnetSchedule Property 
Page 

• add exceptions to a schedule using the BAC Schedule object Edit 
Attributes screen 

For further information on the attributes of the Schedule object, see the 
Schedule/BACnet™ Schedule chapter (LIT-694280) in the Object 
Dictionary. For information on accessing a schedule through a VT100 
interface, see the Working with Schedule Objects chapter 
(LIT-6892070) in the N30 Supervisory Controller User’s Manual. 

© May 1, 2002 Johnson Controls, Inc. www.johnsoncontrols.com 
 Code No. LIT-693235 Software Release 5.1 
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Key Concepts 
Schedule Object 

The Schedule object updates object attributes at specified times, days, 
and dates. Using schedules automates events for specific times. For 
example, you can turn on a fan every day at 7:00 A.M. and turn it off 
every day at 6:00 P.M. 

Exception Schedules 
Exception schedules refine your control of objects by preempting the 
weekly schedule with other instructions on specified days. In the 
example above, you could create exceptions to the fan schedule, so the 
fan would not turn on during weekends or holidays. Several types of 
exception schedules are available. See Table 8-1. 

Table 8-1: Types of Exception Schedules 
Exception Schedule Type Purpose 
Date Allows an exception to the selected schedule on a specific date. 
Date Range Specifies a string of consecutive dates that the selected schedule is 

changed. 
Week and Day Allows an exception to the selected schedule on a specified day of each 

week or month. For example, the second Friday of each month or every 
Monday. 

Calendar Reference Refers to a Calendar object. A Calendar object allows the creation of a 
more detailed exception schedule (for example, holidays that are not 
working days in a building). This Calendar object can then be referenced 
by a schedule as an exception to the normal schedule. See the Adding 
and Editing a Calendar chapter (LIT-693240). 

 

BACnet Schedule 
The Schedule object in Project Builder and the N30 is considered a 
BACnet Schedule object because it supports BACnet functionality. 
Some proprietary attributes have been added by Johnson Controls to 
extend its functionality. 

Time and Value Pairs 
Time and Value Pairs describes the time that an attribute changes to a 
defined state. 
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Event 
An Event is a way of describing a time and value pair. When a time 
and a value are entered, they show up on a schedule as an event. By 
default, an event begins at the specified time and ends either at the end 
of the day (midnight) or at the next defined event for that day. 

Event Colors 
Events (time and value bars) appearing on the M-Schedule tab are 
color coded (text on background) according to the color scheme in 
Table 8-2. 

Table 8-2: Event Color Coding 
Values Appearance 
Integer 0, 1 • black on cyan (light blue) for integer value 0 

• white on blue for integer value 1 
Multistate 0, 1, 2, 3, 4 • black on cyan (light blue) for integer value 0 

• white on blue for integer value 1 
• black on green for integer value 2 
• black on yellow for integer value 3 

Analog First instance is one color, second is another, 
and so on, repeating the four colors for more than 
four different analog values. 
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Detailed Procedures 
Note: The following procedures assume that you already created a 

database and added an N30, a Schedule container, and items 
to be scheduled. 

Adding a Schedule Object 
To add a Schedule object from within Project Builder: 
1. Select the Schedule object from the Object Library. 
2. Drag the Schedule object to the Schedule container in the 

N30 database. 
Note: Click in the text of the Schedule object name to enter a 

descriptive name. 

Setting General Properties of a Schedule 
To set the general properties of a schedule: 
1. Select the Schedule object in the Schedule container. 
2. Select Edit Object on the Edit menu, or double-click the row head 

for the Schedule with which you want to work. The Edit 
Attributes screen for BAC Schedule appears (Figure 8-1). 

 

Figure 8-1: BAC Schedule Object Edit Attributes Screen 
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3. Right-click within the schedule grid, and select Details… from the 
pop-up menu that appears. The BACnetSchedule Property Page 
appears with the General tab selected (Figure 8-2). 

 

Figure 8-2: BACnetSchedule Property Page - General Tab 
4. Fill in the fields of the BACnetSchedule general properties 

according to Table 8-3. 
5. Click OK to apply your changes and return to the project 

database, or click Apply to save changes and continue working in 
the same schedule. 

Table 8-3: BACnetSchedule Property Page - General Tab Fields 
Field Value 
Schedule Name Enter a name for the schedule being created. 
Schedule Description Enter a description for the schedule being created. 
Effective Period - From Enter a date and day for the schedule to begin to take effect. 
Effective Period - To Enter an end date and day for the schedule. 
Enabled Select True to enable the schedule and False to disable the schedule. 
Execution Priority Select a priority for the schedule from the drop-down list. 
Object Category Select the object category under which the schedule falls. 
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Adding Objects to a Schedule 
To add objects to a schedule: 
1. Select the Object tab on the BACnetSchedule Property Page 

(Figure 8-2). The BACnetSchedule Property Page appears with 
the Object tab selected (Figure 8-3). 

 

Figure 8-3: BACnetSchedule Property Page - Object Tab 
2. Click Add, and enter an object reference. 
Note: Enter the object reference exactly as it appears in either the 

Name field or the Full Reference field of the Project Builder 
database. Copy and paste object names or full references 
from the Project Window to ensure accuracy. When a valid 
object is entered, the device where it resides is listed in the 
Objects in Device field located above the Reference 
Object/Attribute grid. 

3. Select the attribute for the object from the drop-down list that 
appears. In the example in Figure 8-3, the Enabled attribute of an 
Analog Totalization object for Heating Stage One is scheduled to 
change state at the times and dates specified by the current 
schedule. 
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4. Click Add to add additional objects to the schedule or Delete to 
remove objects from the schedule. 

5. Click OK to apply your changes and return to the project 
database, or click Apply to save changes and continue working in 
the same schedule. 

Adding Events to a Schedule Using the BACnetSchedule 
Property Page 

To add events to a schedule using the BACnetSchedule Property Page: 
1. Select the Weekly Schedule tab on the BACnetSchedule Property 

Page (Figure 8-2). A blank weekly schedule appears (Figure 8-4). 

 

Figure 8-4: BACnetSchedule Property Page 
2. Select the day of the week on which you want to schedule events. 
Note: If creating a schedule for the whole week, you can copy the 

events from one day to the rest of the days of the week when 
your schedule is complete. See Copying a Day’s Events to 
Other Days in this chapter. 
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3. Click on the Add Event button. The Input Value screen appears 
(Figure 8-5). 

 

Figure 8-5: Input Value Screen 
4. Enter a time and value in the input value screen. The time 

represents when the indicated value is applied to the object 
attribute referenced in the schedule. 

5. Press the Enter key. 
6. Repeat Steps 3, 4, and 5 to schedule an additional change. For 

example, to turn a fan on at 6:00 A.M. and off at 6:00 P.M., 
schedule a time and value for which the input is turned on and a 
second time and value pair to turn it off. 

7. Click OK to apply your changes and return to the project 
database, or click Apply to save changes and continue working in 
the same schedule. 

Adding Events to a Schedule Using the BAC Schedule Object Edit 
Attributes Screen 

To add an event to a weekly schedule using the BAC Schedule object 
Edit Attributes screen: 
1. Select the Schedule object in the Schedule container. 
2. Select Edit Object on the Edit menu, or double-click the row head 

for the schedule with which you want to work. The BAC Schedule 
object Edit Attributes screen appears (Figure 8-1). 

3. Right-click on a day of week on the left side of the screen, and 
check Add Event. A pop-up menu for weekly schedule events 
appears (Figure 8-6). 

Note: If Add Event is already checked, click somewhere else on 
the left side of the screen to close the pop-up menu. 



 Project Builder User’s Guide 8-9

 

Figure 8-6: Right-click Pop-up Menu Over a Day in the 
BAC Schedule Object Edit Attributes Screen 

4. Select the day of the week on the left side of the screen. 
5. Left-click on the time that you want the event to take place. The 

Input Value screen appears (Figure 8-5) with the time set to the 
time on the day’s timeline over which the cursor was when you 
clicked it. 

Note: The cursor appears as a plus sign (+) if Add Event has been 
checked in the pop-up menu and you have the cursor over 
the selected day’s timeline. 

6. Edit the time and value pair as desired. 
7. Press the Enter key to apply your changes, and return to the Edit 

Attributes screen for BAC Schedule. Continue working in the 
same schedule, or click OK to return to the project database. 

Copying a Day’s Events to Other Days 
To copy a day’s events to other days: 
1. Open the BAC Schedule object Edit Attributes screen 

(Figure 8-1). 
2. Select the day with the events that you want to duplicate on the 

left side of the screen. 
3. Right-click, and select Copy Events. 
4. Select the day that you want to have the same schedule of events 

on the left side of the screen. 
5. Right-click, and select Paste Events. 
Note: Any existing events in the weekly schedule for that day are 

overwritten. 

6. Continue working in the same schedule, or click OK to return to 
the project database. 
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Adding Exceptions to a Schedule Using the BACnetSchedule 
Property Page 

To add exceptions to a schedule using the BACnetSchedule 
Property Page: 
1. Select the Exception Schedule tab on the BACnetSchedule 

Property Page (Figure 8-2). A blank Exception Schedule appears 
(Figure 8-7). 

 

Figure 8-7: Blank Exception Schedule Screen 
2. Click Add. The Exception Schedule Creation screen appears 

(Figure 8-8). 
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Figure 8-8: Exception Schedule Creation Screen 
3. Fill in the fields of the Exception Schedule Creation screen 

according to Table 8-4. 

Table 8-4: Exception Schedule Creation Fields 
Field Value/Options 
Priority Enter a priority to determine which exception schedules are run first. 
Period Type - Date Enter a specific date and day (optional) to run the exception to your 

weekly schedule. 
Period Type - Date Range Enter a range of dates and days to run the exception to your weekly 

schedule. 
Period Type - Week and Day Enter a month, week, and day to run the exception to your weekly 

schedule; for example, the second Wednesday of August or the last 
Friday of every (any) month. 

Period Type - Calendar Reference Enter a reference to a Calendar object you have created to use it as 
an exception to a weekly schedule. See the Adding and Editing a 
Calendar chapter (LIT-693240) for more information. 

Effective Period - any month* Enter a specific month to run an exception schedule, or leave it on any 
month to run the exception every month. 

Effective Period - any week* Enter the week of the specified month that you want to run the 
exception schedule. Choices are: any, 1st, 2nd, 3rd, 4th, 5th, or last. 

Effective Period - any day* Enter the day of the specified week that you want to run the exception 
schedule, or leave it on any day to run the exception every day. 

* The effective period fields change depending on the selected period type. 
 
4. Click OK. 
5. Select the new Exception Schedule from the Exception Schedule 

table, and click the Add Event button to define events for this 
Exception Schedule. 
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6. Add additional exception schedules as needed. 
7. Click Apply to save changes, and continue working in the same 

schedule. To return to the BAC Schedule object Edit Attributes 
screen, click OK. To return to the project database, click OK a 
second time. 

Adding Exceptions to a Schedule Using the BAC Schedule Object 
Edit Attributes Screen 

To add exceptions to a schedule using the BAC Schedule object Edit 
Attributes screen: 
1. Open the BAC Schedule object Edit Attributes screen  

(Figure 8-1). 
2. Right-click inside the timeline grid on the right side of the screen, 

and select Exception. The BAC Schedule object Edit Attributes 
exception schedule screen appears (Figure 8-9). 

 

Figure 8-9: BAC Schedule Object Edit Attributes Exception Schedule Screen 
3. Right-click in the timeline grid on the right, and select Add New 

Exception. The Exception Schedule Creation screen appears 
(Figure 8-8). 

4. Fill in the fields of the Exception Schedule Creation screen 
according to Table 8-4. 

5. Click OK. 
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6. Right-click on the timeline grid on the right of the new Exception 
Schedule, and select Add Event to define the events to occur 
during that Exception Schedule. 

7. Add additional exception schedules as needed. 
8. Click OK to apply your changes and return to the project 

database, or continue working in the same schedule. 
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Chapter 9  
Adding and Editing a Calendar 

Introduction 
A Calendar object is a reusable exception to weekly schedules. This 
chapter describes how to: 

• create a Calendar object 

• set general properties of a calendar 

• add dates to a calendar using the BAC Calendar object Edit 
Attributes screen 

• add dates to a calendar using the BACnetCalendar Control 
Property Page 

For further information on the attributes of the Calendar object, see the 
Calendar/BACnet™ Calendar chapter (LIT-694130) of the Object 
Dictionary. For information on accessing a calendar through a VT100 
in Working with Calendar Objects (LIT-6892080) in the 
N30 Supervisory Controller User’s Manual. 

© May 1, 2002 Johnson Controls, Inc. www.johnsoncontrols.com 
 Code No. LIT-693240 Software Release 5.1 
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Key Concepts 
Exception Calendar 

The Calendar object maintains a list of dates designated as exceptions 
to the normal schedule. A Schedule object working from a chosen 
calendar reads the present value of the Calendar object to determine if 
the current day is within the date list of the calendar. 
This object allows a user to accommodate special days, like holidays, 
in which the building controls should run differently from usual. 
For example, you can create exceptions due to changes in the number 
of people or the amount of activity scheduled to take place in the 
building on the specified day. See Table 9-1. 

Table 9-1: Types of Exception Calendar 
Type Purpose 
Single Date Define a single day on which the exception to the 

schedule is to be run. 
Date Range Define a range of days on which the exception to the 

schedule is to be run. 
Week and Day Define a Week and Day on which the exception to 

the schedule is to be run. For example, you could 
choose any day in the first week (Days 1 through 7) 
of January. See Figure 9-1 for an example of a 
BACnet Calendar object definition screen with 
two Week and Day exception calendars. 
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Figure 9-1: Week and Day Exception 
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Detailed Procedures 
Note: The following procedures assume that you already created a 

database, added an N30, and defined a Schedule object. 

Creating a Calendar Object 
To create a Calendar object: 
1. Select the Calendar object from the Object Library. 
2. Drag the Calendar object to the Schedule container in the 

N30 database. 
Note: Click the text of the calendar’s name field in the project 

database to enter a descriptive name. 

Setting General Properties of a Calendar 
To set the general properties of a calendar: 
1. Select the Calendar object in the Schedule container. 
2. Select Edit Object from the Edit menu, or double-click the row 

header for the calendar with which you want to work. The BAC 
Calendar object Edit Attributes screen appears (Figure 9-2). 

 

Figure 9-2: BAC Calendar Object Edit Attributes Screen 
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3. Right-click on the calendar, and select Details from the pop-up 
menu that appears. The BACnetCalendar Control Property Page 
appears (Figure 9-3). 

 

Figure 9-3: BACnetCalendar Control Property Page – 
General Tab 

4. Fill in the fields of the BACnet Calendar general properties 
according to Table 9-2. 

Table 9-2: BACnetCalendar Control Property Page - General Tab 
Field Value/Options 
Calendar Name Enter a name for the exception calendar you are creating. 
Calendar Description Enter a description for the exception calendar you are creating (optional). 
Enabled Select True or False. 
Execution Priority Choose Normal, Urgent, Critical, Life Safety. 
Object Category Choose HVAC, Fire, Services, Security, Administrative. 

 
5. Click OK to return to the BAC Calendar object Edit Attributes 

screen. 
6. Click OK to return to the project database. 
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Adding Dates to a Calendar Using the BAC Calendar Object Edit 
Attributes Screen 

To add dates to a calendar using the BAC Calendar Edit Attributes 
screen: 
1. Select the Calendar object in the Schedule container. 
2. Select Edit Object on the Edit menu, or double-click the row 

header for the calendar with which you want to work. The BAC 
Calendar object Edit Attributes screen appears (Figure 9-2). 

3. Select the date or ranges in the BAC Calendar object Edit 
Attributes screen by clicking on them. 

4. Use the << and >> buttons to select the year. 
5. Use the < and > buttons to select the month. 
6. Click OK to return to the project database. 

Adding Dates to a Calendar Using the BACnetCalendar Control 
Property Page 

To add dates to a calendar using the BACnetCalendar Control Property 
Page: 
1. Select the Calendar object in the Schedule container. 
2. Select Edit Object on the Edit menu, or double-click the row 

header for the calendar with which you want to work. The BAC 
Calendar object Edit Attributes screen appears (Figure 9-2). 

3. Right-click on the calendar, and select Details… from the pop-up 
menu that appears. The BACnetCalendar Control Property Page 
appears (Figure 9-3). 

4. Select the Dates tab (Figure 9-4) to add specific dates or date 
ranges to a calendar, or select the Week and Day tab (Figure 9-5) 
to set a specific day without knowing the date (for example, the 
third Tuesday in July) or a repeating day (for example, the 
last Friday of every month). 
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Figure 9-4: BACnetCalendar Control Property Page - Dates Tab 
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Figure 9-5: BACnetCalendar Control Property Page – 
Week and Day Tab 

5. Select the days on the Dates tab or the Week and Day tab for each 
date, range, or week and day definition, and click Add. 

6. Click OK to return to the BACnetCalendar Edit Attributes screen 
when all days have been entered (Figure 9-2). The dates you have 
added to the Calendar appear highlighted. 

7. Click OK to return to Project Builder. 
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Chapter 10  
Using Queries 

Introduction 
In Project Builder, queries create tabbed sheets to organize the display 
of the data in a project database. This chapter describes how to: 

• add or define a new query 

• edit a query 

• add a column to a query display 

• edit a column in a query display 

• delete a column from a query display 

• delete a query 

© May 1, 2002 Johnson Controls, Inc. www.johnsoncontrols.com 
 Code No. LIT-693245 Software Release 5.1 
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Key Concepts 
Query 

A request for information from a database. In Project Builder, queries 
provide a means of requesting and organizing information in your 
project database. Project Builder provides two types of user defined 
queries: simple and Structured Query Language (SQL). 

Simple Query 
A simple query consists of a standard Boolean search for the specific 
attributes desired. In a simple query, Key 1 is a required field. 
Keys 2 and 3 are optional fields to allow you to expand or refine your 
query. A simple query is based on object attributes, logical functions, 
and values. Multiple attributes can be combined in a single query using 
AND and OR statements. See Table 10-1 for a list of the logical 
functions that may be applied to an attribute in a simple query. 

Table 10-1: Simple Query Logical Functions 
Logical Function Name Returns 
= Equal to All objects that have the chosen attribute with a value that 

matches the value given in the query with the attribute chosen 
<> Less than or greater 

than 
All objects that have the chosen attribute with a value that is 
not equal to the value given in the query, because they are 
above or below the chosen value. In other words, all objects 
that do not have the chosen attribute. This function does not 
apply to Boolean type attributes. 

> Greater than All objects that have the chosen attribute with a value that is 
more than the value given in the query. This function does not 
apply to Boolean type attributes. 

>= Greater than or 
equal to 

All objects that have the chosen attribute with a value that 
either matches or is larger than the value given in the query. 
This function does not apply to Boolean type attributes. 

< Less than All objects that have the chosen attribute with a value that is 
smaller than the value given in the query. This function does 
not apply to Boolean type attributes. 

<= Less than or equal 
to 

All objects that have the chosen attribute with a value that 
either matches or is smaller than the value given in the query. 
This function does not apply to Boolean type attributes. 

LIKE Similar to All objects that have the chosen attribute with a value that is 
similar to the value given in the query. For example, using this 
function with the Object Name attribute and a value of N* 
returns all objects that have a name beginning with N. This 
function only applies to string type attributes. 
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SQL Query 
A more complex query may be written using Structured Query 
Language (SQL). Project Builder uses the Microsoft® Access SQL 
Syntax and its underlying database manager. SQL queries can be used 
with the following attribute names: 

• Object Name 

• Full Reference Name 

• Device Name 

• Class ID 
SQL queries can be used with all other attributes. However, the 
Attribute Number must be used in place of the name. See Table 10-2 
for some examples of Attributes and their corresponding numbers. 

Table 10-2: Attribute Numbers 
Attribute Name Attribute Number 
Description 28 
Units 117 
Input Reference 132 
Analog Alarm Reference 627 
High Alarm Limit 631 
Low Alarm Limit 632 

 

Query Display 
The query display contains the results of a query and may be further 
edited according to your needs. Each query appears as an individual 
tabbed sheet in the project database window. The tabbed sheet is 
divided into rows of objects and columns for specific attributes. These 
columns may be added, deleted, or edited. 
For display purposes, objects returned by a query are placed at the top 
of a hierarchy in the display for that query. Therefore, if an object in a 
query has children, it can be expanded to display them. However, if it 
is a child of another object, you cannot navigate to the parent object of 
an object returned by a query. 
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Default Queries 
Project Builder contains several queries by default. 
Table 10-3: Default Queries in Project Builder 
Query Displays 
All Devices A device-centric view of the project database 
All N2 I/O Points All Input/Output (I/O) point type objects 
All Objects Every object in the current database 
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Detailed Procedures 
Adding or Defining a New Query 

To add or define a query: 
1. Select Add Query from the Format menu. The Add Query dialog 

box appears (Figure 10-1). 

 

Figure 10-1: Add Query Dialog Box 
2. Enter a unique title for your query. A title is a required field. This 

title appears on the tabbed sheet that displays your query results. 
3. Define the query using either the simple query or an SQL query. 

If adding a simple query, the Key 1 field is required, and 
Keys 2 and 3 are optional. If entering an SQL query, use the 
Microsoft Access SQL syntax to define your query. Figure 10-2 
shows a simple query used to return a list of defined alarms. 
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Figure 10-2: Simple Query to Return Defined Alarms 
4. Click OK when done. The query is saved in the project database, a 

new tabbed sheet is added to the current project window, and the 
query is executed to populate the new sheet. 

Note: If you did not assign a unique title for the query, a warning 
box appears stating that the query name already exists. 

Editing a Query 
To edit a query: 
1. Select the tab that corresponds to the query you want to edit. For 

example, the query defined in the Adding or Defining a New 
Query section in this chapter creates a tab named Alarms. To edit 
this query, select the Alarms tab. 

2. Select Edit Query on the Format menu. The Query Definition 
screen for that query appears (Figure 10-2). 

3. Edit the fields as desired, and select OK. 

Adding a Column to a Query Display 
To add a column to a query display: 
1. Select the tab that corresponds to the query display you want to 

edit. For example, the query defined in the Adding or Defining a 
New Query section in this chapter creates a tab named Alarms. 
To edit the query display for this query, first select the Alarms tab. 
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2. Select the column to the right of where you want to insert the new 
column. Selecting a column enables the column commands on the 
Format menu. 

3. Select Add Columns on the Format menu. The Add Column 
dialog box appears (Figure 10-3). 

 

Figure 10-3: Add Column Dialog Box 
4. Fill in the fields using Table 10-4. 

Table 10-4: Add Column Dialog Box Fields 
Field Contains Default 
Look List of Object Classes All Standard Classes 
Attribute Attributes for object class selected in the 

Look field 
Varies according to 
the selected column 

Title Name that appears on the head of the 
column in query display 

Varies according to 
the selected column 

 
5. Click OK. 

Editing a Column in a Query Display 
To edit a column in a query display: 
1. Select the tab that corresponds to the query display you want to 

edit. For example, the query defined in the Adding or Defining a 
New Query section of this chapter creates a tab named Alarms. To 
edit the query display for this query, first select the Alarms tab. 

2. Select the column you want to edit. Selecting a column enables 
the column commands on the Format menu. 

3. Select Edit Columns on the Format menu. The Edit Column 
dialog box appears (Figure 10-4). 
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Figure 10-4: Edit Column Dialog Box 

4. Edit the fields using Table 10-4. 
5. Click OK. 

Deleting a Column from a Query Display 
To delete a column from a query display: 
1. Select the tab that corresponds to the query display you want to 

edit. For example, the query defined in the Adding or Defining a 
New Query section in this chapter creates a tab named Alarms. 
To edit the query display for this query, first select the Alarms tab. 

2. Select the column you want to delete. Selecting a column enables 
the column commands on the Format menu. 

3. Select Delete Columns on the Format menu. 
Note: Selecting Delete Columns immediately deletes the selected 

column. The column cannot be retrieved without adding and 
defining it again. 

Deleting a Query 
To delete a query: 
1. Select the tab that corresponds to the query you want to delete. 

For example, the query defined in the Adding or Defining a Query 
section in this chapter creates a tab named Alarms. To delete this 
query, first select the Alarms tab. 

2. Select Delete Query on the Format menu. 
Note: Selecting Delete Query immediately deletes the selected 

query. The query cannot be retrieved without defining it 
again. 
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Chapter 11  
Uploading and Downloading 

Introduction 
To work with objects that are already in devices and to use completed 
project files requires the ability to upload and download files between 
Project Builder and your N30 System. This chapter describes how to: 

• upload objects to a project database 

• download objects from a project database 

• use advanced download 

• change load options 

• upgrade the firmware and download the database via the upgrade 
utility tool 

• upgrade the firmware and download the database via advanced 
download 

• divide a large site across multiple databases 

© May 1, 2002 Johnson Controls, Inc. www.johnsoncontrols.com 
 Code No. LIT-693250 Software Release 5.1 
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Key Concepts 
Uploading 

Uploading is copying objects from a device’s existing database into 
your project database for editing. 

Downloading 
Downloading is copying code, dictionary, and/or objects from your 
project database into a device. 

Main Code 
Code refers to programmed instructions to your devices. Main code is 
the code within the N30 that is run for normal operation. This is the 
code included in the Main Code, Dictionary and Objects option. 
Project Builder stores this code in flash memory. You can update the 
code through an advanced download using the Main Code, Dictionary 
and Objects option. 
Note: If you are using Advanced Download to download main 

code through the Main Code, Dictionary and Objects option 
and a direct or dial-up connection, your connection speed 
must be higher than 9600 baud. 9600 baud is the default 
speed of Port 1 and 2 on an N30. Use Port 3, which has a 
default baud rate of 57,600. 

Startup Code 
Startup Code is the code within the N30 that is run immediately after a 
device reset or device power up. This code is stored in flash memory 
and is updated through a code download. It performs checksum tests 
on the startup, boot, and main code, as well as other diagnostic tests. It 
also determines whether boot or main code should be run. Startup code 
does not download without the main code. 

Boot Code 
Boot Codes is the code within the N30 that is primarily used when 
attempting to download the main code. The boot code is a minimal 
size version of the main code, designed to support communications 
and code downloads. It is stored in flash memory and updated though 
a code download. Boot code cannot be downloaded without the startup 
and main code. 
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N30 Upgrade Utility 
Due to changes in the database structure of the N30 at firmware 
Revision level 2.x, an upgrade utility has been added to System Tools 
to upgrade the firmware revision level and database from Version 1.x 
to Versions 2.0 and later. 

MIG Download Utility 
The MIG Download Utility is used to download MIG files. MIG files 
cannot be downloaded through Project Builder. For information on 
downloading MIG files from M-Tool, see the Downloading 
Metasys® Integrator 300 Series Code Application Note (LIT-693400). 

Load Manager 
The Load Manager is a component of Project Builder that manages the 
uploading and downloading of objects. 

Load Options 
The Options selection on Project Builder’s Tools menu provides a 
means to change the settings of the Load Manager. 

 

Figure 11-1: Load Options Dialog Box 
The N2 Controller Download Options generally should be left in the 
default selection of Do not automatically load N2 controller when 
controller object is downloaded. You may choose to use the Load 
N2 controller when controller object is downloaded option to get a 
job running on a full download or for an incremental download to only 
a few N2 controllers. To do this, enter the download file name in the 
File name field of the controller object in the M-View screen 
(Figure 11-2). 
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Figure 11-2: M-View Screen 
When downloading N30s with the Load N2 controller when 
controller object is downloaded option selected, the HVAC PRO 
software (.asc), GX-9100 (.dxf), or XTM 101/105 (.dbf) files 
automatically download to the appropriate controller, provided the 
following conditions are met: 

• The file name is entered in the controller object’s File name field. 

• The file resides within the Config Files directory under the current 
project directory. 

If the above conditions are not met, you are prompted for files that 
have been created using the HVAC PRO software, GX-9100 Tools, or 
the XTM Configurator. These files replace any existing files in your 
Application Specific Controllers (ASCs), DXs, or XTMs. The System 
Tools attempt to download every controller attached to a selected N30 
when you download that N30. This can add a significant amount of 
time to your downloads. 
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As an alternative, you can download only selected ASCs and 
DX-9100s by choosing the appropriate controller objects in Project 
Builder. Supported ASCs for the Load Options feature include the Air 
Handling Unit (AHU), Unitary Controller (UNT), and Variable Air 
Volume (VAV) controllers. 
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Detailed Procedures 
Uploading Objects to a Project Database 

To upload objects to a project database: 
1. Connect the computer where Project Builder is running to the 

device from which you want to upload or to an N30 on the same 
network. 

2. Open the project database with the N30s to which you want to 
upload. 

Notes: You must configure the Site using the Edit Site menu prior 
to performing any uploads or downloads. See the Defining a 
Site chapter (LIT-693220). 
The name of the N30 in Project Builder must match the 
name of the N30 being uploaded. 

3. Select the N30s to which you want to upload objects in the project 
database. 

4. Select Upload Objects on the Tools menu. 
5. Click Yes in the confirmation dialog box. 

Downloading Objects from a Project Database 
To download objects from a project database: 
1. Connect the computer where Project Builder is running to the 

supervisory controller to (or through) which you want to 
download or to an N30 on the same network. 

Note: You must configure the Site using the Edit Site menu prior to 
performing any uploads or downloads. See the Defining a 
Site chapter (LIT-693220). 

2. Select the devices to which you want to download objects. 
3. Select Download Objects on the Tools menu. A Download 

warning appears (Figure 11-3). 
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Figure 11-3: Download Warning 
4. Click Yes if you agree. To cancel the download, click No. To 

rename the device before downloading, click Rename Device. The 
Rename and Download Device dialog box appears (Figure 11-4). 

 

Figure 11-4: Rename and Download Device Dialog Box 
5. Make any desired changes, and click OK. Project Builder opens 

the Site Manager, connects to the N30, and downloads the project 
database. The download may be cancelled by selecting Abort on 
the Tools menu. 

Note: When you rename a device, the name of the device in the 
Project Builder database is the New Name for the device. 
The Destination Device Name is the device’s current (or old) 
name. 

6. Check the status window to ensure the download was successful. 



 Uploading and Downloading 11-8 

Using Advanced Download 

IMPORTANT: When changing BACnet™ Internet Protocol (IP) ports 
to an N30 segment that has a Broadcast Management 
object, and performing an advanced download, you 
must download the N30 with the Broadcast 
Management object last. Downloading this N30 at any 
other time prevents Project Builder from 
communicating with the other N30s on the segment. 
 
If using Advanced Download to download main code 
through the Main Code, Dictionary and Objects 
option, and a direct or dial-up connection, your 
connection speed must be higher than 9600 baud. 9600 
baud is the default speed of Port 1 and 2 on an N30. 
Use Port 3, which has a default baud rate of 57,600. 

To use the Advanced Download feature: 
1. Select the device or devices to which you are downloading in the 

project database. 
Note: You must configure the Site using the Edit Site menu prior to 

performing any uploads or downloads. 

2. Select Advanced Download on the Tools menu. The Advanced 
Download dialog box appears (Figure 11-5). 

 

Figure 11-5: Advanced Download Dialog Box 
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3. Select Main Code, Dictionary and Objects. 
Notes: Checking the Dictionary and Objects option updates the 

dictionary that defines the language displayed on a VT100 
attached to the device. Use the Dictionary Language attribute 
on the M-View screen of the N30 Device object to select the 
desired language for the dictionary. 
 
Checking the Main Code, Dictionary and Objects option 
updates the main code (boot code and startup code, if 
necessary) as well as performs the function of the Dictionary 
and Objects option. 

4. Click OK to start the code download. 
Note: You can cancel the download by selecting Abort on the 

Tools menu. 

5. Check the status window to make sure the download was 
successful. 

Changing Load Options 
To change load options: 
1. Select Options on the Tools menu. The Load Options dialog box 

appears (Figure 11-6). 

 

Figure 11-6: Load Options Dialog Box 
2. Select the Load Options using Table 11-1. 
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Table 11-1: Load Options 
Option Description 
Do not automatically load N2 
controller when controller 
object is downloaded 

The N2 controller does not automatically load 
when a controller object is downloaded. This 
option is selected by default and prevents 
lengthy downloads. 

Load N2 controller when 
controller object is 
downloaded 

The HVAC PRO (.asc), GX-9100 (.dxf), or 
XTM 101/105 (.dbf) files download to the 
appropriate controller. This option adds a 
significant amount of time to downloads. 

Save download/upload 
information to file 

Saves the object data file created by the Load 
Manager (.moi) to the Load Files directory 
under the project directory (optional) if 
checked. 

Log download/upload errors Logs the errors from a download or an upload 
if checked (optional). 

 
3. Click OK. 

Upgrading the Firmware and Downloading the Database via the 
Upgrade Utility Tool 

Notes: Due to changes in the database structure of the N30 at 
Firmware Version 2.x, we have added an Upgrade Utility 
Tool to upgrade the Firmware Version from 1.x to 2.0 and 
later. 
The Upgrade Utility tool does not upgrade an N30 that is 
already at Version 2.0 or later. For example, it does not 
upgrade Version 2.0 firmware to Version 5.0 firmware. 
This feature does not transform an N30 into an N30-1, as 
these are physically different devices. The N30-1 has more 
memory and can hold larger databases. 
Use this procedure if a Project Builder database for the N30 
is not available or the available Version 1.x database is not 
current. 

To upgrade the Firmware and download the database via the Upgrade 
Utility Tool: 
1. Connect the N30 devices you want to upgrade to the computer 

where the System Tools is loaded. 
2. Close any running System Tools (or other programs) to avoid 

interference between programs and devices during the upgrade. 
3. Select Programs > Johnson Controls > M-Tool > System Tools > 

N30 Upgrade on the Windows operating system Start menu. The 
Upgrade Utility screen appears (Figure 11-7). 
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Figure 11-7: Upgrade Utility Screen 
4. Select or enter the name of the project with the devices from 

which to upload the objects in the Project section. The Upgrade 
Utility creates the database if it does not already exist, then 
upgrades to the present version. 

Notes: If you do not want to overwrite the contents of this project, 
leave the project name empty. A default empty project is 
created. 
After the project name is selected, the Devices list shows all 
the devices in that project. 
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5. Use the New or Delete buttons to add or remove devices from the 
list. To add a device, click the New button and then type the name 
of the device in the newly inserted line in the Devices list. To 
remove a device, select the device name in the Devices list, and 
click the Remove button. 

Notes: Only the devices in the Devices list are upgraded. 
If the Site name is not automatically displayed in the Site 
drop-down list after selecting a project, then the site defined 
in the database does not exist in the site directory defined on 
that machine. 

6. Click the Directory button to open the Site Book to add 
(or modify) a site. 

Notes: If you left the project name blank to use a default project, the 
site name does not automatically appear. In this case, if the 
site exists, you may select it from the site drop-down list. 
If the database of the project you selected in Step 4 is an 
earlier version than Version 2.0, or if you selected the default 
project (left the project name blank), the Upload objects’ first 
checkbox is enabled. When checked, objects from the 
devices upload from the devices, and then, after the firmware 
and database update, the objects download back to the 
devices. 
The Upload Objects’ first checkbox is selected automatically 
when a project does not exist in order to force the objects 
within the device to upload. 
If the database is already at Version 2.0 or later, the Upload 
objects’ first checkbox is disabled. 
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7. Click the Upgrade button. The status window displays a series of 
messages describing the process of the upgrade. The Exit Upgrade 
button toggles to become the Cancel button during an upgrade. 
The Upgrade Utility performs the following actions: 

• uploads the objects from the device into a Version 1.x of the 
project 

• converts the 1.x Version of the project to the present version 

• upgrades the firmware in the device to the present version 

• downloads the objects from the database created at the present 
version into the upgraded device 

Notes: During an upgrade, the new firmware and database versions 
overwrite the existing firmware and database. The objects 
within the device save to the database in the selected project. 
If necessary, the database upgrades during the upgrade 
process. If you did not select a project, the objects save to the 
default project: 
C:\Documents and Settings\All Users\Application Data\ 
Johnson Controls\M-Data\DataBase\Default Project\ 
UpgradeUtilityTempDB. 

8. Check the status window to make sure that the download was 
successful. If successful, the N30 firmware version is upgraded to 
the present firmware version. 

9. Upgrade additional projects and/or devices as desired. 
10. Click the Rebind button to reinitialize object references in the 

devices on the site after the last device on the site upgrades to the 
present version. Rebind updates addresses in the Site Master N30 
device. 
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11. Click the Exit Upgrade button to close the Upgrade Utility screen. 
Notes: If the selected project is at Version 2.0 or later, the Upgrade 

Utility performs the same operation as the Project Builder 
Advanced Download – Main Code, Dictionary and Objects 
download. 
If the selected device is at Version 2.0 or later, the upgrade 
procedure is cancelled. 

IMPORTANT: Case sensitivity was one of the main changes in the 
database structure between Version 1.x and 
Version 2.0. This was done to better comply with 
BACnet rules. However, some references in Groups 
and Interlock objects, for example, may be broken if 
you upgrade from a Version 1.x N30, which was case 
insensitive. To make sure all bound references are 
maintained after the upgrade, run the Nx Diagnostic 
Tool (zsrdi.exe), which is in the C:\Programs 
Files\Johnson Controls\System Tools directory, and 
select the Command\Get unbound references option. 
Repair as required in Project Builder. 

Upgrading the Firmware and Downloading the Database via 
Advanced Download 

Notes: Use this procedure if you have a database of any earlier 
version existing on your Personal Computer (PC) and you 
want to upgrade and download the database to an N30 with 
it. You need to be sure that the database is up-to-date before 
you proceed, or you will replace the existing database in the 
N30 with an older one. 
This feature does not transform an N30 into an N30-1, as 
these are physically different devices. The N30-1 has more 
memory and can hold larger databases. 

To upgrade the firmware and download the database via Advanced 
Download: 
1. Open the existing project database file Version 1.x in Project 

Builder. A warning dialog box appears asking if you want to 
convert the old file to the latest format. 
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2. Select Yes to convert the file. 
3. Perform the Advanced Download. Make sure to select the Main 

Code, Dictionary and Objects radio button to upgrade the 
firmware code. Refer to the Using Advanced Download section in 
this chapter. 

IMPORTANT: Case sensitivity was one of the main changes in the 
database structure between Version 1.x and 
Version 2.x. This was done to better comply with 
BACnet rules. However, some references in Groups 
and Interlock objects, for example, may be broken if 
you upgrade from a Version 1.x N30, which was case 
insensitive. To make sure all bound references are 
maintained after the upgrade, run the Nx Diagnostic 
Tool (zsrdi.exe), which is in the C:\Programs 
Files\Johnson Contols\System Tools directory, and 
select the Command\Get unbound references option. 
Repair as required in Project Builder. 

Dividing a Large Site Across Multiple Databases 
The following procedure should be considered only if your database 
has become so large that Project Builder stops working with it or 
performance degrades to an unacceptable level. The procedure in this 
section describes how to break up a site into multiple databases. 
1. Define a primary database. The primary database must contain 

full definitions (all objects defined) of the Site Manager and Copy 
Holder N30s and the names of all the remaining N30 devices on 
the site. 
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2. Define secondary databases as needed. The secondary databases 
should contain the full definitions (all objects defined) of all other 
N30 devices on the site. Each secondary database should include 
only the devices that are fully defined in that secondary database. 
Each N30 in these secondary databases must have a placeholder 
(have its exact name defined) in the primary database. 

IMPORTANT: The following items describe changes to Project 
Builder software’s behavior when dividing large sites 
across multiple databases. 

• An object name is checked for uniqueness only in the database 
in which it resides. Project Builder does not compare the 
primary and secondary databases. 

• If a device is added to a secondary database, it must be added 
as a placeholder in the primary database. 

• If the placeholder is accidentally downloaded to a device, it 
replaces the actual N30 database with the default (empty) 
database. 

• Upload of an actual N30 database (that is represented by a 
placeholder) to the primary database adds all the objects to the 
primary database, thus increasing the size of the primary 
database and possibly recreating the performance problems that 
you are trying to avoid. 
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Troubleshooting 
Table 11-2: Uploading and Downloading Troubleshooting 

Error/Condition Problem Solution 
Upload unsuccessful. Site not defined in Site 

Book. 
Choose Edit Site on the Edit menu. The Edit Site 
dialog box appears. Choose the site name from 
the Site Name drop-down list. If the site does not 
exist, click Directory to open Site Book, and add 
your site. See the Site Book User’s Guide 
(LIT-6893100) for more information. 

With a direct serial or dial-up 
(modem) connection, while 
trying to upload or 
download, you receive an 
error message with “Unable 
to read the Model_Name 
Attribute” in the Loader 
status window. 

N30 name in database 
does not match the 
name of the N30 with 
which you are trying to 
communicate. 
Note: Name is case 

sensitive. 

When a direct connection is made, the Site 
Manager displays the name of the N30 to which it 
is connected. Make a direct connection to the 
N30. Start the Site Manager on its own to connect 
to the site. Note the name. Go back to Project 
Builder, update the name in the database, and try 
the upload/download again. 

With an Ethernet 
connection, while trying to 
upload or download, you 
receive an error message 
with “Unable to read the 
Model_Name Attribute” in 
the Loader status window. 

Communications 
problem that may be 
caused by either a bad 
or disconnected cable 
or an improper 
Ethernet setup 

Check your cable connections. 
Make sure your Ethernet setup is correct. See the 
Site Book User’s Guide (LIT-6893100) for more 
information. 

With a direct serial 
connection, while trying to 
upload or download, you get 
a pop-up window with 
Remote Access Service 
(RAS) Error 731. 

The direct serial 
connection is 
connected to the N30 
at the wrong baud rate. 

You can communicate over a direct serial 
connection only if the baud rate defined for the 
N30 port to which you are connecting matches the 
baud rate defined in the connectoid you are using 
for direct serial connections. If you are connected 
to the correct N30 port, edit either the connectoid 
or the N30 so that the baud rates match. See the 
Site Book User’s Guide (LIT-6893100) for more 
information. 

With a direct serial 
connection, while trying to 
upload or download, you get 
a pop-up window with RAS 
Error 602. 

The port to which you 
are trying to connect is 
already in use. 

Make sure that the VT100 Terminal Emulator on 
your PC is not already connected to the port 
through which you are trying to communicate. 

With a direct serial 
connection, while 
attempting to download 
main code, you receive the 
error message “An error 
occurred while 
downloading main code 
to N30. Timed out. 
Aborting-status = 
timeout.” 

Connection speed is 
too slow. 

The connection must be higher than 9600 baud, 
the default speed of Ports 1 and 2 on an N30. Use 
Port 3 (57,600) for the main code download, or 
increase the speed on N30 Port 1 or 2. Make sure 
the associated connectoid speed matches the 
N30 port speed. 

While working with a large 
database, Project Builder 
stops responding, or 
performance becomes very 
slow. 

Database is too large 
for Project Builder. 

Divide the site among several databases. See the 
Dividing a Large Site Across Multiple Databases 
section in this chapter. 
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Chapter 12  
Using the Simulator 

Introduction 
The Simulator allows you to create simulations of an N30 environment 
locally on a workstation. You can then download objects to the 
simulated devices for testing and debugging purposes. These simulated 
devices are able to communicate with each other and any tools or 
components configured to communicate with the simulated site. 
This chapter describes how to: 

• start the Simulator 

• create a simulated device 

• configure a site to communicate with a simulated device 

• remove a simulated device 

• restart a simulated device 

• close all simulated devices 

• exit the Simulator 
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Key Concepts 
Simulator 

The Simulator allows you to test applications by simulating how the 
code runs on an actual N30. Because an object may interact with 
objects on more than one device, the Simulator allows you to generate 
a simulated environment of multiple devices locally on your 
workstation. Then you can download objects to be tested into the 
simulated environment. 
This feature is useful for running through the steps of performing a 
download to check the integrity of the database and the actual 
download action without physically connecting to an N30. Once the 
simulated N30s are loaded with objects, any workstation component 
can interact with the simulated devices in the same manner as the real 
devices. Programs such as M-Graphics and M-Explorer can run in an 
offline mode to generate graphic bindings or tailoring of the M-Series 
operation windows. 
Note: This feature simulates only an N30 and no associated N2 

controllers. Therefore, the functionality of the Simulator is 
similar to that of an N30 with no field devices attached. 

Site Configuration 
The Project Builder communicates with simulated devices using the 
following site configuration: 

• Define the simulation site as an Ethernet Local Area Network 
(LAN). 

• Set the BACnet™ Internet Protocol (IP) port to a value not used to 
avoid communicating with both simulators and real N30s on an 
Ethernet LAN (or, as an alternative, disconnect from the LAN). 

• Enable the Internal Routing parameter located on the Advanced 
Parameters screen of the Site Book. 

Use a simulation site configuration to communicate with simulated, 
not actual, devices. We recommend creating a site specifically for use 
with Simulator devices instead of temporarily modifying an existing 
site to use with the Simulator. 
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Once the configuration changes have been made to the site, select the 
simulation site in the Edit Sites dialog box. Objects can be downloaded 
to the simulated environment using the same method for downloading 
to an actual device. For information on downloading, see the 
Uploading and Downloading chapter (LIT-693250). 
For more information on site configuration, see the Defining a Site 
chapter (LIT-693220) and the Site Book User’s Guide (LIT-6893100). 

Simulated Device 
A simulated device is the simulated N30 environment that Project 
Builder creates for you. You can run several simulated devices at once 
within the Simulator. Each simulated device must correspond to the 
name of the N30 being simulated and have a unique name that is no 
longer than 32 characters. 

Simulation Restart 
Restarting a simulation clears any objects downloaded to it and allows 
you to begin using the simulation again as if you had just created it. 
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Detailed Procedures 
Starting the Simulator 

To start the Simulator: 
On the Project Builder Tools menu, select Simulator. The Simulator 
window appears (Figure 12-1). 

 

Figure 12-1: Simulator Window 

Creating a Simulated Device 
To create a simulated device: 
1. Click New in the Simulator window. The Device Name dialog 

box appears (Figure 12-2). 

 

Figure 12-2: Device Name Dialog Box 
2. Enter a device name from your project database (for example, 

South Building). 
Note: The device names in the Simulator are case sensitive and 

must match the device names in the database exactly. 
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3. Click OK. The new simulated device appears in the Simulator 
window (Figure 12-3). 

N30

New 
Simulated 
Device South Building

 

Figure 12-3: New Simulated Device in the Simulator Window 

Configuring a Site to Communicate with a Simulated Device 
To configure a site to communicate with a simulated device: 
1. Open the project that you want to download to a simulated device 

in Project Builder. 
2. Select Edit Site from the Edit menu. The Edit Site dialog box 

appears (Figure 12-4). 

 

Figure 12-4: Edit Site Dialog Box 
3. Click Directory. The Site Book window appears (Figure 12-5). 
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Figure 12-5: Site Book Window 
4. Look at the Connection attribute for your project’s site. If it is 

currently set to Ethernet, continue to Step 5. If it is set to another 
value, double-click on the attribute, and select Ethernet from the 
drop-down list. 

5. Click Advanced. Additional attributes appear in the window. 
Scroll down to the Internal Routing attribute. 

6. Double-click on the Internal Routing attribute, and select Enabled 
from the drop-down list. 

7. Click Close. The Site Book window closes, and the Edit Site 
dialog box remains visible. 

8. Click OK on the Edit Site dialog box. The dialog box closes. 
Note: When finished using the simulated environment, set the site 

communication properties back to the original settings. 

Removing a Simulated Device 
To remove a simulated device: 
1. Select the simulated device you wish to remove in the Simulator 

window. 
2. Click Remove. The simulated device no longer appears in the 

Simulator window. 
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Restarting a Simulated Device 
To restart a simulated device: 
1. Select the simulated device you wish to restart in the Simulator 

window. 
2. Click Restart. All objects downloaded to the simulated device are 

cleared, and the simulated device is restarted. 

Closing All Simulated Devices 
To close all simulated devices: 
In the Simulator window, click Close All. All simulated devices are 
removed from the Simulator window. 

Exiting the Simulator 
To exit the Simulator: 
Click the Close button on the Simulator window (Figure 12-6). 

exit

Close Button

 

Figure 12-6: Close Button on the Simulator Window 
If any simulated devices are running when you attempt to exit the 
Simulator, the dialog box in Figure 12-7 prompts you to verify that 
you wish to close all simulated devices. Click Yes to exit. 

 

Figure 12-7: Exit Verification Dialog Box 
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